
User Guide
6.0.0.0 — Last update: Jan 13, 2021

Solvency II Solutions

Copyright © 2021 Solvency II Solutions



Table of Contents
Coronavirus Update ................................................................................................................................... 6

Latest NCA responses to EIOPA Recommendations ............................................................................... 7
Step-by-step instructions for creating “partial” xbrl submissions .............................................................. 8

Welcome ................................................................................................................................................... 12

Read Before Starting ................................................................................................................................ 13

Quick Start Guide ..................................................................................................................................... 15

Definition of Terms................................................................................................................................... 16

Architecture of Application...................................................................................................................... 18

Installation ................................................................................................................................................ 22

Return Setup............................................................................................................................................. 24
Create a New Return ............................................................................................................................ 25

Company Overview.......................................................................................................................... 26
Company Details ............................................................................................................................. 28

COMPANY ................................................................................................................................. 29
BS CUR...................................................................................................................................... 30
SCR ........................................................................................................................................... 31
BS OTHER ................................................................................................................................. 32
COUNTRY.................................................................................................................................. 33
FAC............................................................................................................................................ 34
IE BRANCH................................................................................................................................ 35
IE CLAIMS (AY) ......................................................................................................................... 36
IE CLAIMS (UY) ......................................................................................................................... 37
IE COUNTRY ............................................................................................................................. 38
IE NST ....................................................................................................................................... 39
INV............................................................................................................................................. 40
LI LOB........................................................................................................................................ 41
NL .............................................................................................................................................. 42
NST............................................................................................................................................ 45
PART ......................................................................................................................................... 46
RFF ............................................................................................................................................ 47
UK NST ...................................................................................................................................... 49
UK NST LIAB (AY) ..................................................................................................................... 50
UK NST LIAB (UY) ..................................................................................................................... 51
UK NST CFs............................................................................................................................... 52

Select Your Return Type.................................................................................................................. 53
QRT Selection ................................................................................................................................. 55



Roll Forward .................................................................................................................................... 57
H.HV Sheet (Historical Value Template) ..................................................................................... 61

Change Your Return ............................................................................................................................. 62
Change Company ............................................................................................................................ 63
Remove a QRT................................................................................................................................ 65
Add a QRT....................................................................................................................................... 66

Managing Multiple Companies .............................................................................................................. 68

The Workbook .......................................................................................................................................... 69
Contents Tab ........................................................................................................................................ 70
QRTs .................................................................................................................................................... 72

Calculations ..................................................................................................................................... 74
Data Points ...................................................................................................................................... 77
Formatting ....................................................................................................................................... 78
Edit Links......................................................................................................................................... 79
“Tabular helper” QRT Data points .................................................................................................... 80

Unregistered Tabular Workbooks .......................................................................................................... 81
DB Settings ..................................................................................................................................... 82

Upgrading a workbook .......................................................................................................................... 85

QRT Navigator .......................................................................................................................................... 87
QRTs .................................................................................................................................................... 88
Narrative Report.................................................................................................................................... 90
Your Audit Logs .................................................................................................................................... 92
QRT Drill Down ..................................................................................................................................... 93

Importing Data .......................................................................................................................................... 94
CSV .................................................................................................................................................... 100

CSV Specifications ........................................................................................................................ 102
XML .................................................................................................................................................... 103
Excel................................................................................................................................................... 104
XBRL Import ....................................................................................................................................... 106
Structured file import ........................................................................................................................... 108
Database Connection.......................................................................................................................... 110

Team ....................................................................................................................................................... 111
Team Export ....................................................................................................................................... 112
Manager.............................................................................................................................................. 117

Workflow ................................................................................................................................................. 120
Workflow Plan ..................................................................................................................................... 121
Workflow Status .................................................................................................................................. 125
My Tasks ............................................................................................................................................ 128

Tables ..................................................................................................................................................... 129



Append Rows...................................................................................................................................... 130
Delete Rows ....................................................................................................................................... 131

Validations .............................................................................................................................................. 132
Validation Report ................................................................................................................................ 133
Validation Error Types......................................................................................................................... 135
Validation Comments .......................................................................................................................... 136
Hide/Auto-unhide validation result in report ......................................................................................... 140
Whitelist/Blacklist/Greylist rules setup ................................................................................................. 142

Output ..................................................................................................................................................... 146
Export CSV ........................................................................................................................................ 147
Export Excel ....................................................................................................................................... 149
Export XBRL ...................................................................................................................................... 151
Export XML ........................................................................................................................................ 153
Export NST & SFCR .......................................................................................................................... 155

Non-ECB specific output ..................................................................................................................... 157
Non-ECB Excel output ................................................................................................................... 158
Non-ECB XBRL output................................................................................................................... 159

Print......................................................................................................................................................... 160

Audit........................................................................................................................................................ 162

Reference / Regulatory Hub................................................................................................................... 163

Notes and Procedure Notes ................................................................................................................... 171
Add Note............................................................................................................................................. 172
Show All Notes.................................................................................................................................... 175
Edit Note ............................................................................................................................................. 176
Add Procedure Note............................................................................................................................ 179
Edit Procedure Note Template ............................................................................................................ 182
Checklist ............................................................................................................................................. 185
Edit Checklist item .............................................................................................................................. 186

Show All Procedure Notes ............................................................................................................. 189

Other ....................................................................................................................................................... 190
Malta ANST 08 A specific.................................................................................................................... 191

Ways to collaborate in Tabular .............................................................................................................. 194

XBRL Introduction.................................................................................................................................. 195
How Tabular Generates XBRL ............................................................................................................ 196
XBRL Introduction ............................................................................................................................... 197
XBRL Glossary ................................................................................................................................... 198

Taxonomy...................................................................................................................................... 202



Instance Document ........................................................................................................................ 203
Reporting Fact/ Fact ...................................................................................................................... 204
Context .......................................................................................................................................... 205
Unit................................................................................................................................................ 206
Reporting Entity / Entity ................................................................................................................. 207
Period............................................................................................................................................ 208
Dimension ..................................................................................................................................... 209
Dimensional analysis ..................................................................................................................... 210
Dimension Member........................................................................................................................ 211
Explicit dimensions ........................................................................................................................ 212
Typed dimensions.......................................................................................................................... 213
Enumerations ................................................................................................................................ 214
Dimension Domain......................................................................................................................... 215
Reporting Concept ......................................................................................................................... 216

Breaking Down An XBRL File.............................................................................................................. 217

XBRL Technical Implementation ........................................................................................................... 222
XBRL Data Points ............................................................................................................................... 223

Duplicate Data Points .................................................................................................................... 224
Inconsistent Data Points ................................................................................................................ 225
Important Data Rules ..................................................................................................................... 226
Numeric Formats ........................................................................................................................... 227
Scaling of Numeric Values ............................................................................................................. 228
XBRL The Submission ................................................................................................................... 229

XBRL List QRTs.................................................................................................................................. 230
Reportable Columns ...................................................................................................................... 231
Table of List QRT Datapoints ......................................................................................................... 232
Foreign Key Relationships ............................................................................................................. 233
Line Identifier ................................................................................................................................. 234

XBRL Filing Rules ............................................................................................................................... 236
XBRL Miscellaneous ........................................................................................................................... 237
XBRL Architecture Appendix ............................................................................................................... 238

XBRL Support ......................................................................................................................................... 240
XBRL Support Documents .................................................................................................................. 241
XBRL Troubleshooting ........................................................................................................................ 242

PRA............................................................................................................................................... 243
FSC ............................................................................................................................................... 244
DMB .............................................................................................................................................. 245
CBI ................................................................................................................................................ 246

XBRL Appendix ...................................................................................................................................... 247
Table of list QRTs and Key Descriptors............................................................................................... 248



Consolidation ......................................................................................................................................... 249
PCC Consolidate ................................................................................................................................ 250
Group Consolidate .............................................................................................................................. 252

Narrative Reporting ................................................................................................................................ 254
Data Source Manager ......................................................................................................................... 255
Data Links........................................................................................................................................... 256
Chart or Table Object .......................................................................................................................... 258
Format Manager ................................................................................................................................. 259
Manage Fields .................................................................................................................................... 260
Custom Fields ..................................................................................................................................... 261

Siimplify .................................................................................................................................................. 262

Tools ....................................................................................................................................................... 264
Manage custom sheets ....................................................................................................................... 266
Reset Tool .......................................................................................................................................... 267
About .................................................................................................................................................. 268
QRT Sign Off ..................................................................................................................................... 269

Analytics report generator ................................................................................................................... 272
Analytic Reports ............................................................................................................................ 274

Auto-generation of Central Bank of Ireland NST 13 ............................................................................. 277
Adding/Editing/Removing custom NST.13 rules ............................................................................. 278

Retrieve timestamped return workbook ............................................................................................... 280
S.19.01 data entry interface ................................................................................................................ 283

Convert S.19.01.01.LISTV to QRT layout....................................................................................... 285
Import from S.19.01.01.LISTV QRT layout file ............................................................................... 287

QRT visibility....................................................................................................................................... 289
Validations for visible QRTs ........................................................................................................... 293
Hidden QRT settings...................................................................................................................... 294

Return workbook cell formatting .......................................................................................................... 295
Formula auditing ................................................................................................................................. 297

System Admin ........................................................................................................................................ 300
Administer Users/Roles....................................................................................................................... 301

Create/Edit User ............................................................................................................................ 302
Create/Edit Role ............................................................................................................................ 303

One Click Upgrade.............................................................................................................................. 306
Settings............................................................................................................................................... 308

System Options ............................................................................................................................. 309
Dynamic tolerances ................................................................................................................. 311
Annotate output ........................................................................................................................ 312
Reduced network load (RNL).................................................................................................... 314
Disable Zip Compression.......................................................................................................... 315



Support Options............................................................................................................................. 316
Logging .................................................................................................................................... 317

Logging level....................................................................................................................... 318
Environment logging ........................................................................................................... 319

DB Options .................................................................................................................................... 320
Update goldencopy return variant ............................................................................................. 321

Known Tabular issues............................................................................................................................ 323

Troubleshooting ..................................................................................................................................... 332
I Can’t Get Started .............................................................................................................................. 333

I Can’t Login to Tabular ................................................................................................................. 334
Tabular is too Slow ........................................................................................................................ 335

I Made a Mistake................................................................................................................................. 336
I Made a Mistake, How Can I Revert Back? ................................................................................... 337

I Have a Problem with Excel ............................................................................................................... 338
I See Some Strange Effects in Non-Tabular Workbooks ................................................................ 339

I Have a Problem with a QRT.............................................................................................................. 340
I’m Missing a QRT ........................................................................................................................ 341

S.06.02 * .................................................................................................................................. 342
I Have an Extra QRT...................................................................................................................... 343
A QRT is Missing Data Points ........................................................................................................ 344
The QRT Structure Looks Incorrect................................................................................................ 345

I Have a Problem with a Formula ........................................................................................................ 346
A Formula is Incorrect.................................................................................................................... 347
A Formula is Missing ..................................................................................................................... 348
I Want to Add my Own Formulas.................................................................................................... 349
I Want to Link to an External Workbook ......................................................................................... 350
C0170 is showing 0 in S.06.02.01.01/SE.06.01.16.01 etc.. ............................................................ 351

I Have a Problem Importing................................................................................................................. 352
I Have a Problem with a Validation...................................................................................................... 353

I Don’t See the Validation that I am Expecting ............................................................................... 354
I Have a Problem with Reg Hub .......................................................................................................... 355

I Can’t View Regulatory Hub .......................................................................................................... 356
I Have a Problem with XBRL ............................................................................................................... 357

My XBRL File will not Load into our Regulator Portal ..................................................................... 358
I Have a Problem with Tables.............................................................................................................. 359
I can’t create a return .......................................................................................................................... 360

I can’t create a return because it says I have opened workbooks ................................................... 361
Corrupted workbooks that need repair................................................................................................. 362

Useful Information.................................................................................................................................. 364



Coronavirus Update
All updates relating to special requirements or flexible arrangements related to covid-19 are available in this
section.
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Latest NCA responses to EIOPA
Recommendations
The EIOPA recommendations for “Supervisory flexibility regarding the deadline of supervisory reporting and
public disclosure – coronavirus/covid-19” are available here on their website: https://www.eiopa.europa.eu/
content/eiopa-issues-recommendations-supervisory-flexibility-regarding-deadlines-supervisory

Please see below NCA responses to these recommendations that we are aware to date – it is important of
course that you should verify your local NCA’s position in complying (or not) with EIOPA’s
recommendations. We will be attempting to track any NCA responses and include links to these in this page.

Bank of England:
https://www.bankofengland.co.uk/prudential-regulation/publication/2020/covid19-regulatory-reporting-
amendments
In general these follow the EIOPA recommendations – however the BoE is more lenient regards the
quarterly submissions, with a blanket 4 week delay being provided. Note, for UK NSTs (annual only
submissions) an 8 week extension is also provided.

Updates to follow.
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Step-by-step instructions for creating
“partial” xbrl submissions
EIOPA’s recommendations with regard to the Coronavirus/COVID-19 situation allow for an initial “partial”
xbrl submission with a small number of “core” QRTs included, to be followed with a “full” xbrl submission at
a later date with all required QRTs included. This page sets out how to successfully create the initial partial
xbrl submission within Tabular.

Due to generic xbrl rules you cannot declare in S(E).01.01 template that a QRT is not reported but at the
same time have any values in that QRT worksheet – this fails a xbrl consistency check.

Thus, if you wish to exclude a QRT (that is in your return workbook) from the xbrl output you must clear all
values from the worksheet. Of course this is not ideal as you likely want to keep these values to finalise
them in the later submission. As such we recommend following the below approach to create a copy of your
return workbook and use this workbook to clear values from such QRT worksheets and generate the initial
xbrl from that copy workbook. Then you can revert to your original return workbook file and continue with
finalising the numbers.

1. Make a copy of your original return (rename as appropriate eg “Initial partial”)

2. On opening this copy return you will get warning message ‘Return is not registered’. But ignore it, in this
case you will not need to update it. Just click Ok button.

3. Go to S.01.01.01. You will need to set ’0 – not reported other reason (in this case special
justification is needed)’ next to QRTs that you will not report in this partial initial submission.
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So, in the end, you will have ’1-Reported’ status only next to those QRTs that you are planning to report.

4. Then you should go to each of these associated QRTs you’ve marked as Not Reported and delete all
values and formulas from them.
You will need to delete ALL values, user formulas, and Tabular formulas as well. ‘0’ values also should be
deleted.
Note: Deleting all values and user formulas and Tabular formulas in workbook copy will not affect your
original return workbook.

To delete Subtotal formulas (cells with Subtotal formulas are filled violet) from QRT you should go to
Subtotals in the ribbon -> Selected QRT -> Delete formulas
To delete Reference formulas (cells with Reference formulas are filled orange) from QRT you should go to
References in the ribbon -> Selected QRT -> Delete formulas
To delete Interaction formulas (cells with Interaction formulas are filled green) from QRT you should go to
Interactions in the ribbon -> Selected QRT -> Delete formulas
When all Tabular formulas are deleted, cells will look like this:
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After this, you will be able to delete all values from these cells as well.
Note: In case you set ’0 – not reported other reason (in this case special justification is needed) next to
eg.S.19.01.01.01 in S.01.01.01 that means that every S.19.01.01 QRT in this workbook should be totally
empty.

Note: Only values in Z name ranges in QRTs like 19.01 can stay.

5. After this, you can export workbook to XBRL and then revert back to the original workbook and continue
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to populate the full set of QRT worksheets.

Solvency II Solutions User Guide - 6.0.0.0

Page 11 of 365



Welcome
Welcome to the User Guide for Tabular from Solvency II Solutions Ltd.

About Us

Read more about Solvency II Solutions on our website: About Us

Contact Us

If you have any questions whilst reading, get in touch here: Contact Us

Solution Overview

View a demonstration video and read about our solution features here: About Tabular

Tabular in a Nutshell

Tabular is the industry’s leading Excel-based Solvency II narrative and QRT XBRL reporting tool integrated
seamlessly into Microsoft Office.

Aim of this Guide

This User Guide aims to provide Tabular users with adequate information on how to perform both basic and
advanced features available in the reporting tool, as well as troubleshooting tips on how to solve common
issues. This documentation also includes an extensive glossary of general and technical terms to help users
get started with Tabular and QRT reporting within Solvency II in general.
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Read Before Starting
Tabular is a powerful and full feature reporting tool developed to make the business of Solvency II reporting
easier than it has ever been. It’s Excel-based design enables Tabular to be very easy and convenient to use
from installation to daily report generation. However, this tool comes with guidelines and restrictions that all
users of Tabular must follow.

Warning – Before you Start Tabular Read Fully

It is very important not to make any form of changes in any of Tabular’s system folders and files. If you
do, the application will no longer be supported by Solvency II Solutions Ltd. and a complete re-installation
will be required to continue using it without any issues.

Please follow the guidelines below to ensure that your Tabular reporting tool will run smoothly and our
technical support coverage will not be voided:

1) Never change a file saved in the ProgramData folder.

2) Never move a file from the ProgramData folder.

3) Avoid moving a return or Tabular from its default location as much as possible to avoid the risk of
affecting the integrity and usability of the application. But if it is unavoidable, we highly recommend that
somebody with relevant IT skills and experience will perform this activity. A single missing system folder or
file will render your copy of Tabular unusable, so all required files must be copied to the new location. You
must ensure that:

• you have write access to the new location
• your virus scanner does not block any files in the Tabular folder
• the files are not copied as read only
• the files are copied to either a local location or network location that is fast enough to support Tabular

usage (data transfer speeds of at least 1 Mbps are generally acceptable for most users)
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4) Always start Tabular by navigating to a return xlsm file in your installation location, alternatively navigate
to Tabular.xlsm to create a new return.

5) Tabular R2.2.1.0 supports opening multiple returns at the sametime, along with any other Excel file on
the same PC.

6) Always archive / backup test / old returns and old Tabular installation folders to avoid confusion in the
future. These old folders will not be compatible with new versions of Tabular, unless you specifically
upgrade the old returns. Please contact Tabular Support for assistance on how to do this.

7) Keep your files and folders clearly structured and well organised at all times.
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Quick Start Guide
Here are some quick questions you need to answer to get started with Tabular.

Do you have the Tabular plugin installed on your computer ?

Some users are able to do this themselves after directly downloading from the website. Other users will
have to wait for their internal IT support staff to complete this step.

Do you know where the Tabular folder has been placed in your network?

The default name of the folder is Tabular. There is a possibility that your internal IT support staff has
changed this during the installation process, so consult with them if you cannot find the Tabular folder.
Some users place this folder locally on their PC, while others place this in a network drive. A few would let
their internal IT support staff decide the location for them.

If you answered YES to both questions, then navigate to the Tabular folder and double click on Tabular.xlsm
as shown below.

This is your starting point when creating your very first return. You can now proceed to the Return Setup
after you read the guidelines and restrictions found on the Read first section of this User Guide.
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Definition of Terms
To get started on the right track with Tabular, this section provides a compilation of the most important
general and technical terms used frequently within the User Guide and the reporting tool itself. It is
important that each Tabular user should be familiar with each of the terms mentioned in order to get a
clearer understanding and better appreciation of the application and its features.

General Terms

Audit
Trail

A historical log or list of records that provides documentary evidence and details of the sequence
of activities that have taken place in the system at any given time

Closed
List A series of data points within a drop down menu which holds the fixed list of all possible values.

Hybrid
QRT A type of QRT that combines the features of both List and Static QRTs in a single template

List QRT A type of QRT that is structured in a table format, adopting a horizontally-formatted template

Narrative
Report

A Microsoft Word document (.docx) generated by Tabular with the use of a Word Add-In for
narrative reporting.

QRT Stands for Quantitative Reporting Template. Each worksheet in a Tabular return is referred to as a
QRT.

Static
QRT A type of QRT wherein each item is arranged per row, adopting a vertically-formatted template

Tabular An Excel-based Solvency II reporting tool that can generate reports in XBRL format.

Template Refers to the structure or format followed by the whole QRT

Tolerance A acceptable tolerance for a validation to still pass even if the value is not exact.. Some validations
have a tolerance of +/- 1 for example.

Validation
Report

Document which includes the results of the validation process, the cell being tested, as well as
actual and expected results. It also includes a description of the test.

Technical Terms

Append To add row(s) to a table.

Consolidate To append data to another existing data (relevant to the table only).

Drill Down Functionality available on every calculation cell that will parse the formula into its constituent
data points, and provide the value for each.

Excel Add-
in

An Excel-based application that runs within the Excel framework. The user interface resides in
the Add-Ins tab of MS Excel’s Ribbon.

Filtering A mechanism wherein a subset of data that satisfies a certain criteria will be returned. It provides
a quick and easy way to find and work with a data in a range of cells or a table.
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Formula
Links A method of entering data into a report from external workbooks as

Metadata Refers to a set of data that describes and gives information about other data.

Override To supercede one or more conditions in favour of another condition(s) introduced into the data
set.

Param A field used to identify which set the import file is for when mapping during a CSV data import.
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Architecture of Application
Tabular consists of two components:

Excel Add-In (Component A) – An extension that runs within Microsoft Excel

Tabular Folder (Component B) – A folder that can be placed on your local PC / a file server.

A simple representation of this is below (click to enlarge)

A more complex representation of each component, sub-elements, how they interaction and some system
pre-requisites are included here (click to enlarge)
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Excel Add-In (Component A)
The component that’s running as an application within MS Excel and introduced as a tab in the MS Excel
Ribbon is called the ‘Tabular Excel Add-in’. It acts as the primary user interface where all of Tabular’s
features can be accessed and configured. All report customisation and data manipulation options are also
found here.

This component is delivered via an .msi installer. The .msi installer contains an executable program that
installs Tabular for the user who is currently logged in to the computer. We can also provide an installer for
all users on the machine if required.

Since the Tabular Add-In is an application-level extension of Excel, it will run at every time Microsoft Excel
is opened, however the functionality is only available if you have opened a Tabular return xlsm file.

The Tabular Add-in is responsible for guiding the user through using all of the available features in the
application. It communicates with the Database (which is contained within Component B) where required.
This component is also responsible for managing the creation of new returns and saving them into
Component B for future use.
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The Tabular Folder ( Component B )
The ‘Tabular Folder” is a system folder containing the database, your Excel workbooks, and other critical
system files required to run Tabular.

This Excel file ‘Tabular.xlsm’ is the entry point of the system. It is a standard .xlsm file and is used to create
new returns and perform other administration tasks.

ProgramData folder contains a number of different supporting files . This includes our filesystem based
database (.sdf file), export templates, narrative reporting templates. These are all system files and are not
used directly by the users.
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A number of XBRL mapping files are contained with the ProgramData folder. These are all system files and
are not used directly by the users.

Contained within the Tabular folder is the filesystem based database (Tabular.sdf file). This type of
database is used so that no complex setup or configuration tasks are required to support the installation.

More information on SQL Compact
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Installation
The Tabular installation must be run on all machines in which Tabular Workbooks or Word documents are to
be accessed.

Please follow the steps below. Note that the installation requires admin rights on the PC:

1. Log in with the Windows user with which you will be using the Add-in (no need to be Admin user)

2. Uninstall previous version of Tabular if you have it installed from Start -> Control Panel -> Uninstall a
program

3. Please make sure you have all the prerequisites installed:

• Microsoft .Net Framework 4.0 or later
• Microsoft SQL Server Compact 4.0 SP1
• Open XML SDK 2.5 for Microsoft Office

4. Download TabularInstaller.msi and NarrativeReportInstaller.msi from customer area of
http://www.solvencyiisolutions.com and install them.

5. Download and unzip Tabular Workbook folder to your Desktop or ‘My Documents’ area where you have
full access rights. With the trial version it is highly recommended that you create new returns with the latest
workbook and discard test workbooks created with the previous version

6. The entry point for the system is via opening Tabular.xlsm from your unzipped folder location
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Return Setup
The Return Setup is the process of preparing and organising all the required data to create a return. This
section covers everything you need to complete the task.

To create a return, open Tabular.xlsm (NOT TabularS2.xlsm or any other file in ProgramData folder) using
Microsoft Excel version 2010 or 2013.
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Create a New Return
To set up a new return please click on Return Setup in the ribbon.

The Return Setup task pane will open which will capture all of the required information needed to generate
the correct QRTs in the location of your choice.
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Company Overview
COMPANY SELECTION

In the Return Setup Window, select an existing company from the Company Name drop down or add a
new company within the COMPANY Tab.

To add a new company, click the Create Company button on the right:

Once the Company Name is created, all the fields with drop down will be automatically filled by default.
However, the user can choose other options from the drop down menu as needed.

Click the Next button to complete company creation.

SUPERVISORY SECTION

Changing the location of a company will automatically update all other relevant fields in this section. You
can still change these settings later.
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GROUP REPORTING SECTION

In the Reporting Type field found under Corporate Structure:

a. if Group Entity is selected, you need to choose one of the options for the group solvency calculation.
b. if either Solo Entity or Lloyd’s syndicate is selected, no need to make additional Group Reporting
options.

Additional information about each field can be found by hovering the mouse pointer over the blue “i”
(information) icon where available like the example shown below:
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Company Details
Different companies have different requirements to generate documents such as company returns and other
reports. This means each company return or report requires a lot of information to complete. This
information varies depending on the nature of the company.

To avoid having a large volume of data in a single window, Tabular provides a systematic and organised
way of presenting reports with the use of Tabs (fig.below). In each Tab, sets of related documents can be
grouped and categorised together in a single worksheet called QRT or Quantitative Reporting Template.
Tabs make the reports “clutter-free” and saves user from browsing and scrolling. Plus they also have a
chance to review and make updates on the data at a later time if necessary.

Click the following sub-sections to see the different Tabs for creating a return in Tabular.
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COMPANY
The Company Tab is the first tab in the Return Setup Window. It is also the only tab that is initially
enabled by default.

By default, the Company Tab is categorised into seven sub-sections, namely:

1. Company
2. Supervisory
3. Corporate Structure
4. Business Profile
5. Non-Life Business
6. Outward Reinsurance
7. Other Reporting

Another sub-section called Life Business will also be shown if the business type is “Composite”. However,
if the selected Reporting Type is Group, Non-Life and Life Business sub-sections will be hidden and
Group Reporting section will be displayed.

All other tabs in the Return Setup Window will be generated through the selections made inside the
Company tab.

Learn more about the Company Tab here
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BS CUR
BS CUR Tab refers to Balance Sheet Reporting by Currency Information. This Tab is used to add
currencies that need to be reported separately on the assets and liabilities by currency disclosures.

Currencies can be removed by right clicking on the currency line and selecting Remove Currency as shown
below.
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SCR
The SCR Tab is used to select which SCR risk modules are to be reported within the return. Certain options
will be disabled depending on the company’s Business Type found in the COMPANY Tab (e.g. life
underwriting SCR risk module is not enabled for non-life companies) and the Internal Model Type set for
the company (this is shown in the grey label above the check boxes).

In the SCR selection (picture above), Non-life health and Health catastrophe risk were split into individual
sub-categories:

• For non PCC entity these selections only hide or show sections from a single S.27.01.01 QRT.
• In PCC case S.27.01.01 is broken down into different sub-QRTs, and only those sub-QRTs that relate

to the sub-categories selected will be included in the return e.g if windstorm risk is selected then
SR.27.01.01.WI (specific QRT worksheet for reporting Windstorm sub-section of SR.27.01 will be
added to the return workbook. This is to reduce the size of PCC aggregated returns as several full
SR.27.01.01 worksheets in the return workbook significantly increases the size of the return
workbook.

When a full internal model is selected but a user wishes to include the standard formula QRTs within the
workbook, he or she needs to override all the default selections in the QRT SELECTION Tab to accomplish
this.

The Part of Annex I Risks Covered check box should be checked when an adjustment to the absolute
floor of MCR is required because risks within Annex I are covered.
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BS OTHER
The BS OTHER Tab contains Additional Balance Sheet Reporting information, including intra-group
transactions.

The first section has three visible items. However, the Additional Branch Balance Sheet Information
check box as shown below will only be added if the Reporting Type located in the COMPANY Tab is set to
“Third Country Branch”.
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COUNTRY
The COUNTRY Tab shows details of activity per country. It is only visible if the Business Undertaken
Outside Home Country check box found under Business Profile sub-section of the COMPANY Tab is
checked.

Countries of business for the activity QRTs is added using the Add Country drop down menu.
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FAC
FAC refers to Facultative Reinsurance of life- and non-life lines of business. This Tab shows up when
“Facultative Reinsurance” check box found under Outward Reinsurance sub-section of the COMPANY Tab
is checked.

Check the corresponding box of each Line of Business whenever there is facultative reinsurance cover in
place.
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IE BRANCH
It is required that insurance corporations complete this template on a Solo/Individual basis.The aggregate
values entered for the head office/subsidiary resident in Ireland should include anybusiness written through
FOS/FPS (Freedom of Services/Freedom to Provide Services) and branches/FOE (Freedom of
Establishment) licenses by that insurance corporation.
The aggregate values entered for any non-resident branch with their head office resident in Ireland should
include any business written through FOS/FPS (Freedom of Services/Freedom to Provide Services) by that
insurance corporation.

The options needed to generate the IE BRANCH tab in the return setup are shown below:

In the IE BRANCH tab, select each country (outside or inside the EEA) in which the Irish company has a
branch established:
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IE CLAIMS (AY)
The IE CLAIMS (AY) Tab only shows up when the location of the company is in “Ireland” and both NST
check box as well as the NS06 Claims Development and Accident Year Basis Business check boxes
found under Non-life Business sub-section of the COMPANY Tab are all checked.
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IE CLAIMS (UY)
The IE Claims (UY) Tab is added only when the location of the company is in “Ireland” and both NST check
box as well as the NS06 Claims Development and Underwriting Year Basis Business check boxes found
under Non-life Business sub-section of the COMPANY Tab are all checked.
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IE COUNTRY
The IE COUNTRY Tab is added into the Return Setup window when location is set to “Ireland” and
Business undertaken outside home country check box in the COMPANY Tab is checked.

Select from Add Country drop down menu to select countries.
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IE NST
The IE NST Tab is added only if the location of the company is in “Ireland” and NST check box is selected.
This tab also holds the overview of reportable NST information.
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INV
The INV – Additional Investment Reporting Tab will be visible when “Additional Asset Reporting” is
selected in Other Reporting section of the COMPANY Tab.

This Tab also holds reportable asset templates in additional to line-by-line or summary reporting on the
overall asset holdings.
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LI LOB
LI LOB refers to Life LOBs or Lines of Business information. This Tab is used to select the line of business
that needs to be reported separately, by currency, in the return.

Depending on the COMPANY Tab settings, the non-proportional lines of business will be enabled or
disabled.

Classes of insurance for the reporting of business by country can also be set in this tab (disabled for the trial
version).
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NL
NL refers to Non-Life LOBs or Lines of Business information. This Tab is used to select the lines of
business that needs to be reported separately, by currency, in the return. You can also select the applicable
line of business and currency combinations here.

Depending on the COMPANY Tab settings, the non-proportional lines of business will be enabled or
disabled.

The default currency in the LOB table is the reporting currency set for the company. Additional currencies
can be added as required through the Add Currency drop down above the table.

To remove currencies not required from the table, right-click on the currency’s column header and select
Remove Currency: Note that the default (reporting) currency cannot be removed from this table.
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From version 3.0.0.0 of Tabular there are two new columns added to the Non-life table :

only reporting currency exposures’ column – select this option where, for the indicated line of business,
all exposures all in the reporting currency. With this option selected, Tabular will not include the currency
level version of S.19.01 in the return workbook – however it will be generated in the xbrl export. For
example, if for the Income protection line of business the only exposures are in Euro, and the insurer’s
reporting currency is Euro, then EIOPA still want to receive an S.19.01.01.IP for total Income protection line
of business as well as S.19.01.01.IP.EUR QRT, even though the figures in both are identical as no FX
conversions take place between the currency and total S.19.01 data sets.
Selecting only reporting currency exposures’ column removes the “duplicate” worksheet from the return i.e.
S.19.01.01.IP.EUR will not be included in the return to reduce the size of the return workbook. However,
export to xbrl process will “generate” the S.19.01.01.IP.EUR QRT within the xbrl file, so that EIOPA continue
to receive both data sets in the xbrl.

XXX exposure column – select this option where there are immaterial currency exposures for a line of
business and you wish to include a S.19.01 worksheet in the return to enter these amounts and have the
total worksheet then balance with the material currency sheet(s) and the immaterial currency total. Note the
immaterial currency sheet (eg S.19.01.01.IP.XXX) will NOT be exported to xbrl, it is simply there to help
reconcile the total level S.19.01
Note: this column only shows when XXX Immaterial currencies combine in the drop-down is selected
(shown below)
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Non-Life annuities are set in exactly the same way as the Non-Life annuities table (disabled for the trial
version).

Classes of insurance for the reporting of business by country can also be set in this tab (disabled for the trial
version).

Solvency II Solutions User Guide - 6.0.0.0

Page 44 of 365



NST
NST stands for National Specific Templates. If NSTs are available in the location selected in the COMPANY
Tab, the NST check box will be enabled. Ticking the NST check box will reveal additional NST options that
will enable several tabs in the Return Setup:

If the location selected is Ireland, additional options relevant to that country’s NST will be enabled such as
NS06 Claims Development (Accident Year Basis Business and Underwriting Year Basis Business) and
NS04 – Non-Life Technical Provisions – Detailed Split by LOB and Country

Solvency II Solutions User Guide - 6.0.0.0

Page 45 of 365

http://www.manula.com/manuals/solvency-ii-solutions/tabular/1/en/topic/company


PART
Participation can be selected under Corporate structure in Company tab (fig shown below). It contains the
QRT that specifies information on participation held by the undertaking and an overview of the calculation of
the deduction from own funds related to participations in financial and credit institution.

This option enables PART tab, which holds the reportable participation information. This consists of 7 sub-
tables of information, for the different type of participation (which receive different treatment for the SCR)
under Solvency II.
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RFF
For Ring-fenced fund / Matching adjustment portfolio reporting, select the option under other reporting
section of the company tab:

The setup for ring fenced fund / matching adjustment portfolio is done in RFFMAP tab shown below:

Settings:

• Reporting Code – this field holds the firm or company RFF reporting code. The number has to be
consistent over time and should be used to identify the ring-fenced funds and the matching portfolio
number in other templates.

• Fund Name – indicates the name of a ring-fenced funds or matching adjustment portfolios. The name
should be unique and be kept consistent over time.

• Article 304 – indicates whether the RFF is under Article 304 of Solvency II Directives. Choose one of
the option from the drop down that applies.

• Sub-MAP – indicates if the fund has other funds embedded.
• Active – if the fund requires to be reported then ticked the box, deselect otherwise. Note that this tab

is disabled by default, to enable it Reporting Code and Fund name field must have entries.
• Add Rff – if the firm has more than one RFF to be reported, click this button to add new table with

system code F2 as the figure below shows:
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When all required field under system code F1 completed, each RFF QRTs has “.F1” at the end of the
worksheet name e.g. SR.01.01.01.F1. The same rule applies for matching adjustment portfolio field, the
worksheet name will have M1 at the end for system code M1.
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UK NST
The UK NST Tab is activated if the NST check box in the COMPANY Tab is checked. NST stands for
National Specific Templates.
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UK NST LIAB (AY)
The UK NST LIAB Tab is added when both NST and Liability Business in Non-Life Business Accident
Year Basis Business check boxes in the COMPANY Tab are selected.
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UK NST LIAB (UY)
The UK NST LIAB (UY) Tab is added when NST and Liability Business in Non-life Underwriting Year
Basis Business check boxes in the COMPANY Tab are selected.
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UK NST CFs
This tab shows when company location is UK with NST and NS-10 Projection of future cash flows are
selected in the company tab. This holds the reportable non-life lines of business and currencies information
for the PRA cash flows reporting template as shown below:
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Select Your Return Type
Here, details such as Type of Return and Reference Dates are to be selected.

Reference Date

For both the “annual” and “quarterly” option, you need to select a Reference Date (which corresponds to
the end of your reporting period). In the case of “quarterly” selection, you also need to select a Quarter
Number.

Technical entry point – this is only to be used when specifically directed by your national supervisory
authority to submit using the “Technical entry point”.

Ad-hoc – Where an insurer is requested to submit an “ad-hoc” return (eg reinsurance resubmission,
significant or very-significant IGT and other scenarios leading to NCA requesting an ad-hoc submission)
then the “ad-hoc” checkbox should be selected.

If it is the special case of material changes to the reinsurance program during the year requiring the
resubmission of the S.30 QRTs then (ensuring Annual return option is selected), choose Ad-hoc option then
ticked special case reinsurance resubmission checbox. Also ensure that the SFCR and NST checboxes are
deselected in the bottom section of the Return tab, then the QRT selection screen will only give you just the
template you need for re-submission (i.e S.30 and S.31 templates).

If you are required to submit “Ad-hoc” reporting of intra-group transactions (templates S.36.01, S.36.02,
S.36.03 or S.36.04) under ITS2015/2450 Article 21 then use the second checkbox under Ad-hoc for the
correct templates to be auto-selected (based on the intra-group transaction selection in the “BS Other” tab
of return setup) in the QRT Selection Tab. Tabular will also set up S.01.02 Ad-hoc settings correctly. Note
this checkbox is only available if Annual return period selected.
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Return Types

In the full Solvency II reporting set, it is possible to configure the report whenever applicable, including the
public, private, and financial stability templates, or any combination of these as required:

National Specific Templates

For locations where NSTs or National Specific Templates are available (e.g. UK, Ireland), the NST check
box is enabled. Checking the NST check box enables the NST tab in Return Setup:
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QRT Selection
Based on the selections made in the preceding tabs, the QRT table will include all applicable QRTs for the
Company Type (Solo/Group/Lloyds) and Reference Period (Annual/Quarterly/Ad-hoc) selected, grouped
by the EIOPA QRT groupings (e.g. Information, Assets etc.). Within that set of QRTs, those relevant to the
business profile and other selections made will be made available. Any QRT that is not selected as it is not
required for submission can still be included within the return by selecting IncludedOver from the drop
down as shown below.

Once the QRTs for inclusion in the return are selected, the final step in the Return Setup is to choose
where to save the return files (workbook, word document and supporting files). The first section under the
sub-section Workbook Details is where you can assign the Workbook Name, the narrative report name
(RSR, SFCR) and the System Location or the location of where the files will be saved (the default is where
you have all your Tabular files saved).

By clicking this you will be able to browse other folder and save the files where you want.

Creating a Return

Once you are happy with all the Templates and Lines of Business for the return, you can now create the

Solvency II Solutions User Guide - 6.0.0.0

Page 55 of 365



return by clicking “Create Return” at the bottom of return setup window:

The new return is created in the system memory. Once this process is complete, the Tabular.xlsm file will be
close automatically. The network location of the newly created return will then open automatically in
Windows Explorer. Open MS Excel like a regular spreadsheet and log in to the return to commence working
with the new return:
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Roll Forward
Roll Forward is a process wherein data, formula or information within a return will be carried across to the
newly created one. To create a roll forward the user must have return(s) of the same type for that company.
For instance, to roll forward a Quarterly, you must already have a quarterly return created.

To do this:
In the return setup company tab, select reference return: Previous annual return and/or Q4 return.
Note: It is possible to select only previous annual return or both options at the same time.

Note: Quarterly user can only roll forward from one other quarterly, while Annual can roll forward from
another annual and quarterly of same reference date i.e. Q4 return

The information to be rolled-over to the new return depends on the options users selected:

• Preserve User formula – when this is ticked, any user formulas (i.e. formulas in the return that are
not Tabular formulas such as Subtotal, Interaction etc.) including external formulas added to the
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previous return will be taken into the new roll forward return; otherwise, no formulas will be copied
across. Please note that formulas from “static” QRTs (such as S.02.01) and “list” QRTs (such as
S.06.02) are copied across.
NOTE: With 4.1.0.0 Tabular version, to roll-forward user formulas you must have the QRTs Signed-
Off in the reference return, otherwise no formulas will be rolled forward. So for the first time using this
feature, you would need to go back to old returns and Sign-off QRTs before creating the new return.

• Non-life development triangles – when selected it will populate the S.19.01 of the newly created
return with reference formula retrieving data from the previous return, essentially moving everything
up one diagonal in the triangle leaving only the last diagonal for user to complete.

NOTE With 6.0.0.0 Tabular version, you have the option to use S.19.01 data entry interface (detailed
information here). In this case values will not be rolled-forward to S.19.01.01.LISTV sheet. To get all rolled-
forward values in S.19.01 to your S.19.01.01.LISTV sheet in current return you should:
- select Non-life development triangles option in the roll-forward section on creating return;
- when return is created select Convert S.19.01.01.LISTV to QRT layout in Tools -> Include Tabular
formulas in output file (output file will include all Tabular roll-forward formulas, so values from the previous
return will be added to S.19s accordingly). More detailed information on Convert S.19.01.01.LISTV to QRT
layout here.
- to add those roll-forward values to original return > select Import from S.19.01.01.LIST output file in Tools
> select output file from the previous step -> all roll-forwad values will be imported to S.19.01.01.LISTV
sheet. More detailed information on Import from S.19.01.01.LIST output file here.

• Brought – forward / Prior year figures – this will populate data in year N-1 data points eg S.23.03
brought forward capital amounts and S.29 opening best estimate

• “Static” amounts – SCR from Previous quarter this brings forward the SCR figures from previous
quarter. It will populate the single datapoint in S.28 from the reference return.

• “Static” amounts – Basic and ancillary own funds from previous quarter when ticked it populates
all S.23.01 from previous quarter figures.

• “Static” amounts – Basic and ancillary own funds (only relevant for annual return creation) –
when ticked it populates all S.23.01 from Q4 return.

• “Static” amounts – Basic and ancillary own funds (only relevant for annual return creation) –
when ticked it populates all S.23.01 from previous annual return.

• “Static” amounts – Annual balance sheet from Q4 balance sheet (only relevant for annual
return creation) – when this option is selected, Tabular roll-forward will complete all data points (with
the exception of those, such as technical provisions, that are derived from other QRTs within the
same return) within S(E).02.01 C0010 [Sii value] using the Q4 return values.

• “Static” amounts – Annual premiums, claims, expenses from Q4 premiums, claims, expenses
(only relevant for annual return creation) – when this is selected, Tabular roll-forward will complete
all data points (with the exception of those that are derived from other QRTs within the same return)
within S.05.01 using the Q4 return values.

Note: You may also hover on the tooltip icon beside each option in Tabular for information about its

Solvency II Solutions User Guide - 6.0.0.0

Page 58 of 365



function.

NOTE: In case you selected preserve user formulas from the last year’s return but none are actually carried
through into the new return:

1. First of all, check if previous return was signed off.

Starting from 4.1.0.0 Tabular version we’ve introduced a new QRT Sign-off feature (Tools > QRT sing-off
manager) in this version and this affects the roll-forward user formulas feature (not roll-forward value ie
H.HV, that is still currently the old solution).
To roll-forward user formulas, you must have the QRTs Signed-off in the reference return. So unfortunately
for the first time using this feature, you would need to go back to old returns and Sign-off QRTs before
creating the new return.

Note, the formulas are saved in the Tabular db so if you need to make a subsequent edit to the QRT
worksheet later you can “unsign-off” (using the same window) the QRT and this will re-load the formulas
back to the QRT worksheet. You can do sign-off and un-sign-off as many times as you need.

But that are the only changes. More info about Sign-off you can find here

Note: In case QRTs in previous return were not signed-off, user will get a warning message that there are
QRTs in previous return that were not Signed-off. It is possible to cancel process by clicking Cancel button
and then go back to the previous return and sign-off QRTs that you need. But in case user selects Ok button
in warning message window roll-forward process will run, but user formulas from not signed-off QRTs will
not be rolled-forward.

Solvency II Solutions User Guide - 6.0.0.0

Page 59 of 365



2. In case after 1st step user formulas still not preserved you will need to set previous return as Goldencopy

Previous year (reference) return should be set as a Golden copy return.

So please open previous return again and set it as golden copy via: Tabular ribbon -> System Admin ->
Settings -> DB Options -> Update goldencopy return variant
More instructions” here”:#list-of-return-variants. After this just try to create a new return with this one as
reference return again ( with preserve user formulas and other options you need ticked)
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H.HV Sheet (Historical Value Template)
From Tabular version 3.0.0.0, when creating new returns an additional helper sheet (H.HV) is created within
the return that holds the Historical Values from any reference returns selected. Tabular loads into this H.HV
sheet all the “static” (e.g. sheets like S.02.01, S.12.01 but not “list” QRTs like S.06.02, S.09.01 etc.) data
from the reference returns. The H.HV sheet is the source for Tabular reference formulas (the formulas that
uses to fill the new roll forward return with data).

More about H.HV sheet:
1. This sheet is set up in same way as validation report and audit logs; the data is not editable, but can be
filtered by users. To check the data of a certain QRT within the H.HV sheet just click the drop-down arrow
(picture below).

2. Data is not updated automatically, so users must be aware when data is stale and out of date eg if a
resubmission occurs on the reference return then the H.HV sheet has to be reset using the ‘refresh H.HV
helper sheet’ option in Tools tab so the H.HV has the updated data

3. Tabular does not verify that the correct reference return has been selected eg if a user is creating the Q3
return but selects the Q1 return (instead of Q2 return as the reference return), Tabular will not recognise this
and the Q1 return will be loaded into H.HV and used in reference formulas as if this was the Q2 return. To
correct an incorrect reference return being selected, go to EDIT return and change the selection in the
reference return drop down of the QRT Selection tab. Check roll forward section for details.
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Change Your Return
There are instances wherein you need to make some changes in your return.

In order to make necessary updates to an existing return, just open the return workbook and select Edit
Return in the MS Excel Ribbon as shown below:
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Change Company
In the Edit Setup Window, all the Tabs and its properties selected when the return was first created will be
displayed:

Navigate your way down to each Tab and make the desired changes. All Tab properties can be updated.
However, there are a few exceptions:

COMPANY Tab (reporting type, business type, reporting currency and location)
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RETURN Tab (reference dates and financial stability reporting

QRT SELECTION Tab (workbook details)

Once all changes are made, click Save Return.
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Remove a QRT
There are two ways on how to remove a QRT. You can:

1. Deselect the option that generates this QRT in the Edit Setup Window. Here’s one example:

Quarterly Reporting Exemptions is selected in this scenario which triggers to include S.06.02.01- List of
asset.

If deselected, S.06.02.01 will not be included in the QRT SELECTION Tab. “Remove” is affixed to the
Added/Removed column for this QRT similar to what is shown here:

2. Manually override the existing rule by selecting “NotInlcudedOver” option from the drop down in the QRT
SELECTION Tab:

3. Click Save Return to apply the changes.
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Add a QRT
Adding a QRT to a return can be done by these steps:

1. Click Edit Return in the MS Excel Ribbon.

2. Select the properties required for that QRT.

In this scenario let’s add S.08.01.01. By selecting additional asset reporting option, INV Tab will be added.
Make sure quarterly reporting exemption is already selected as well.

Go to INV Tab by clicking the Next button and select Open Derivatives.

3. In the QRT SELECTION Tab, you’ll see S.08.01.01 is included. “Added” is affixed in the Added/
Removed column for this QRT.
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4. Save the return.

OVERRIDE:

If you wish to manually override the QRT and skip the above steps:

1. Go to QRT SELECTION Tab.

2 Click the drop down option for this QRT and select “IncludedOver”

3. Save Return.
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Managing Multiple Companies
Created returns are saved in the system’s database. Therefore, you can select the same company in the
Company Name drop down of the Return Setup Window to create another version.

This process can be repeated as many times as needed to create multiple versions of the company.
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The Workbook
The return workbook consists of multiple worksheets and each worksheet are in a separate tab in this order:

Contents, QRT sheets, Validation Report

Note that the Validation Report sheet (tab) is added only when you run the validation test.

The workbook must be locked to prevent unwanted changes. Check if this protection has been applied by
clicking File in MS Excel’s menu bar as shown below:
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Contents Tab
The Workbook Contents tab is the very first tab (leftmost) in the Workbook file. This section summarises
and lists down the following Workbook items in a table format:

• List of QRTs included in the Workbook with hyperlink direct to the specific tab
• Title of each QRT
• Description of each QRT,
• Tab Type
• Date Added

Tab Link

From the Workbook Contents tab, you can go straight to a specific QRT by clicking the title of the QRT
found under the Tab Link column. Refer to the diagram below.
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QRTs
Quantitative Reporting Templates or QRTs refer to the spreadsheets inside the Return Workbook.These
templates provide the information that needs to be reported, such as balance sheet, premiums, claims and
expenses, own funds, and more.

The QRTs are arranged orderly per tab at the bottom portion of the Workbook, depending on how many
QRTs the Return has:

Types of QRTs:

• Static QRT

• List QRT – is a type of QRT structured in a table format.
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• Hybrid QRT – has both features of Static and List QRTs.
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Calculations
Data entry and supporting tools

In addition to importing data, changes can definitely be made directly in the Excel QRT cells.

Calculation cells
The cells that can be changed are the white cells. The coloured cells are calculated cells which cannot, by
default, be changed:

Subtotal cells
The purple cells are those with a formula bringing in data points from the same QRT.

Reference cells
The orange cells are those with a formula from the Tabular roll-forward feature. These formulas will always
include at least one value from the H.HV sheet (but may also include values from other sheets eg in S.29.01
where the formula calculates the difference between the current return value and the previous return value).
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Interaction cell
The green cells are those with a formula with cells in another QRT.

In addition, when you create return Tabular tried to add a formula into every cell following this order:
1. It will try to add a subtotal.
2. If there is no subtotal available then it will try and add interaction
3. And finally if no interaction it will try and add reference.
As a result, some QRTs have a mix of different colours like s.29.01 for instance.

The calculated cells should automatically update. However please check that your calculation options in the
Excel Formulas menu is set to automatic as per the screen below.

Removing/ replacing calculations
If a user so chooses, they can remove (and subsequently replace) any calculation from a cell, QRT, or
Workbook.

This is done in the Validation section of the ribbon.
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Select the type of calculation you wish to remove. For example, if a user wanted to remove the subtotal
calculation from the selected cell:

Closed lists
Some data points are restricted to a closed list of possible values. Such cells are indicated with a light grey
cell fill and entry into these cells is done through a drop down menu which holds the full list of possible
values:
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Data Points
Data Points

A Data Point refers to the intersection of columns and rows in the Workbook. Note that the column and row
name of each Data Point is taken from the Workbook and not from MS Excel.

To know which Data Point you are at, check the name box as shown below:

Closed Lists

Some Data Points are restricted to a Closed List of possible values. Such cells are indicated with a light
grey cell fill and entry into these cells is done through a drop down menu which holds the full list of possible
values:
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Formatting
Tabular has a distinctive format applied to the whole workbook. In any case it gets broken although it
seldom happens or modified by users, you can restore or replace its formatting with this steps:

1. Click Tools > Reset > Format

2. Select among the three (3) options you wanted to replace. Then click replace format

The selected cell, QRT or workbook will again have the formatting used in Tabular.
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Edit Links
When user create external references between workbooks to bring information from a source workbook into
a destination workbook, it might be very difficult to manually trace all links specially if the workbook has a
vast external references.One very helpful tool to workaround with it is using Edit Links which can be access
under Tools in the ribbon (this opens the edit link window without restriction as the sheet is locked).

Edit Links manager will open if your sheet contains some external references and it display all the files to
which your spreadsheet is linked to;

Here, you can:

• verify the workbook you want the external reference to point to is correct
• change the source workbook in an external reference
• remove formulas
• update values.

Solvency II Solutions User Guide - 6.0.0.0

Page 79 of 365



“Tabular helper” QRT Data points
Around a dozen additional data points have been added across the QRTs to account for common cases
where the Tabular formula must be overwritten eg. S(E).06.02 C0170 formula for CIC 71,9; or S(E).02.01
R0220 (‘Assets held for index-linked and unit-linked contracts’) formula where the amounts not available in
S(E).06.02 must be included in the data point

These data points are marked as either row code “TR” (eg S.02.01 _C0010_TR0220) or column code “TC”
(eg S.06.02 TC0170) and displayed with light blue labels.

These “helper datapoints”:
- are NOT submitted in your xbrl output
- they are in the Tabular return to help specific scenarios where users commonly needed to remove a
Tabular formula (ie the green, purple, orange cells with formulas added by Tabular) because the formula
was not correct for their specific scenario
- for scenarios like the above, the “helper datapoints” can be used to enter the information not available in
the return to allow the formula to work correctly

For example, we added TC0171 to SE.06.02 because of the EIOPA rule that states that for assets that are
CIC 71 or 9 then C1300 and C0140 must be left empty. Thus, for these assets, the default formula in C0170
can not produce the correct result and previously users had to remove the formula from C0170 and enter
directly into C0170 the Sii value for these assets.

Now, instead of removing the C0170 formula users can simply enter the Sii value for the CIC 71 and 9
assets into TC0171 and this will be fed into the updated C0170 formula. Note, and there are validations to
help enforce this, you should ONLY use TC0171 for CIC 71 and 9. For all other assets, you complete
C0130/C0140 and C0370 and C0380 as normal as before.
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Unregistered Tabular Workbooks
When a copy of a Tabular return workbook is made or the return workbook is moved to another location, it is
considered as “unregistered Tabular workbook”. The dialog from the screenshot below shows every time
you open it:

These can still be used but note the main database is not aware of this workbook, so we apply the following
limitations to this workbook as the will not work properly:

• audit tracking will not be saved
• data upgrades will not be applied
• return is not available for roll forward and comparison
• return backups will not be created
• some functionality is disabled – Edit Return, Manage custom sheets, Team, Return Recovery

If you have this message showing for you consider this two variants:
1. If the return workbook you are opening is a copy of the original one, but you want to keep it and test some
stuff using it – then continue using it with the following restrictions noted above, but do not use it for the
filing of your official data.
2. If this is the original return workbook that was created by Return setup, but you have moved it to a new
location – register this new path, so the new proper path to the workbook is saved to the Database.
Check DB settings section to guide you how to do that.
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DB Settings
User needs to align a return workbook or Database when it is moved to a different location, otherwise you
may have limited access to the full features of Tabular.
There are two different processes involved, depending which needs to be aligned: a return workbook or the
path to the database

Here’s how:

A. If it is a return workbook moved to a different location, opening the return will give you a warning
message that you need to update the path in the main DB.
1. Sign in as administrator in the log-in area of the open return.
2. Go to System Admin in the ribbon and click DB Settings.

3. Click Update in the dialogue box.
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4. A message will show to confirm that path is successfully updated.

B. When the central DB is moved to other location

1. Open the main Tabular workbook and log-in as Administrator.
2. Go to System Admin in the ribbon and click DB Settings.
3. In the dialogue box, select the path where the new central DB is located and click Update. Note that the
path should be to ProgramData folder (do not add the file name as well, just the ProgramData)

4. A confirmation message will show once update is successful
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Upgrading a workbook
With the change in 5.0.0.0, one click upgrade no longer upgrades your workbooks, instead, this is done
when you first open a workbook that is due to be updated. Note that Tabular uses some internal rules to
determine if the return is in scope for an upgrade (e.g. workbooks from previous years will not be flagged for
return upgrade). If you get the following message when you open your workbook, in general users should
click yes and wait for the process to finish (only for scenarios where the upgrade process is causing issues,
eg repeatedly failing, would we advise to click no so that users can continue to work with the (un-upgraded)
return in the meanwhile while those issues are investigated by our support).

This process will do a few different things:
1. Apply any structural changes to the templates (add/remove data points etc..)
2. Change any dropdown values of closed list fields. Note this will not change any values you have in these
fields, but that should be flagged by validations if the value you selected is no longer relevant.
3. Will update formulas (note any formulas that you have removed manually and you have added your own
will not be overwritten)

Sometimes if the process does structural changes to a QRT, you might see some strange formatting like:

• Some borders being gone on column headers etc..
• Cells and labels not being word wrapped, which you can fix with resizing the columns/rows
• Other random changes like some label is not properly indented or not in bold etc..

All of these are just cosmetic differences that are hard to implement in the upgrade process, but will not
affect validations or XBRL generations in any way. You might just need to do a little bit of resizing of the
columns to get a comfortable view.
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Note that if you select not to perform the Upgrade of the return now, you will still be able to use it, however,
you will keep getting the upgrade message every time you open it and we generally advise you to do the
upgrade before the final validation check and XBRL generation as it may contain changes that are important
for your submission.
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QRT Navigator
The QRT Navigator allows the user to navigate around the Return with ease. This feature provides access
to QRTs, Narrative Reports, and the exported files such as CSV, Excel, XML and XBRL as well as Audit
Logs . By clicking the drop-down button of the QRT Navigator in the MS Excel Ribbon, you’ll see the options
as shown here:

Note that for this to function as expected, you must have the respective files beforehand, otherwise nothing
will happen.
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QRTs
The QRT Navigator task pane provides hierarchical structure of the Return Workbook, showing the type
and QRT description like the one below:

To show the task pane and navigate to a specific QRT, follow these steps:

1. Click the QRT Navigator drop-down button.
2. Select QRTs.
3. Select a QRT within the tree view to navigate that QRT.

To hide it, simply click the QRT Navigator icon or the task pane’s Close [x] button.

Furthermore, certain actions or functionalities such as validation can be initiated on QRTs through the
navigator. By right clicking on the QRT in the tree view, a context menu shows with validation options.

Show all test option shows the whole validation result including the failing values. While Shows only
errors filters the result to show only the failing values.
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Narrative Report
A Narrative Report is a MS Word file where a user can import relevant fields from the main Workbook
QRTs or from an additional MS Excel spreadsheet to keep the quantitative disclosures within the qualitative
reports in sync.

The default filename of a Narrative Report matches the naming convention of the Workbook as shown
below.

Here is how you can link the data to your SFCR Narrative reporting document:
1. Open Narrative reporting document.
2. Add a new SourceFile that will point to the already exported from Tabular SFCR (English) workbook.

3. After you have added a data source to the SFCR workbook go to the “Chart or table Object” area of
Narrative reporting pane. Select Table then the worksheet to import. In the last Name field — user should
search for an entry containing DP inside (this are named ranges we have added specifically for that
purpose). This named range covers all the meaningful data points from the sheet so by adding that user will
get the full sheet linked:
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All the SFCR sheets can be inserted in the Narrative report this way. Note that this template is reusable if a
user needs to do the same for another company. They just need to copy this Narrative reporting file — it will
keep all this links. Go to the Data Source manager on top and click on the change path button and then
navigate to the SFCR export of the new company.
Then you need to click on the Refresh all button.

This will refresh the values so they are taken from the newly linked SFCR file for the second company. (note
the refresh process might take some time depending on how much data you have linked to the template)
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Your Audit Logs
The Audit Log holds a record of every static data point changes, actions, or activities undertaken by a user.
Each record shows the value, user, change from – to, time of change, and sub-type of change. Like all other
files, all Audit Logs are also saved to its corresponding folder Audit report archive.

To view the Tabular Audit Logs, click QRT Navigator and choose Your Audit Logs.

Here’s an example of an Audit Log:
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QRT Drill Down
Another way to easily navigate around the return is to use the drill functionality available on every
calculation cell. For any calculation cell, right click on the cell and choose “Drill-down” in the context menu:

This will parse the formula into its constituent data points, and provide the value for each; any of which can
be clicked on to navigate directly to that cell within the return.
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Importing Data
Importing refers to a command or process that assists the user in filling in the data into the QRT Data
Points accurately.

The following file types are supported by the Tabular import routine:

• CSV
• XML
• Excel
• XBRL

Here are the steps on how to import data into the Tabular Workbook:

1. Click the Import button in the MS Excel Ribbon.

2. Select the appropriate type of file to import in the context menu as shown in the image below. Choose
SELECTED QRT option if you wish to import data only to a specific QRT, or choose WORKBOOK to import
into the entire Return.

3.The Import task pane will be displayed with several configurable options:

OVERWRITE INTERACTIONS

For Data Points within the Return that were derived from other Data Points (e.g. subtotals), the default
setting is not to import into the cells to replace the formula. However, this can be changed through this
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setting (note, all calculation formulas can be retrieved from the database at any point, see Calculation cell
section).

IGNORE DATA VALIDATION

For data points within the return which are limited by the taxonomy or other restrictions to a closed list of
valid values or particular data formats then the default setting is not to import values which are not
compliant with those rules. However, this can be changed through this setting.
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If ignore data validations is set to “no”, then those invalid valid values will not be imported (note: valid values
will still be imported). If ignore data validations is set to “yes”, then those invalid valid values will be
imported along with the valid data.

OVERWRITE NON-MONETARY

For numeric data points which don’t represent monetary values (such as risk factors and other ratios) and
text and date fields, this setting will set whether the value will be overwritten from the import file or not.

CONSOLIDATE

To append data to existing data (relevant for table QRTs only) the append option (default setting) should be
selected. To overwrite existing data and replace select consolidate.

OVERWRITE — table QRTs

When consolidate is not selected for a table QRT the current contents of the QRT will be removed and
replaced with the import file.

OVERWRITE — static QRTs

Similar to table QRTs, when consolidate is not selected for a static QRT the current contents of the QRT will
be removed (calculations excluded unless overwrite calculations is also selected) and replaced with the
import file.
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APPEND — table QRTs

When consolidate append is selected for a table QRT the current contents of the QRT will be remain and
the contents of the import file will be appended below.

APPEND — static QRTs

When consolidate append is selected for a static QRT the current contents of the QRT will be remain and be
“consolidated” with the contents of the data file. For example, if S.02.01.1 data point C0010_R0050 contains
34 and the import file for this data points contains 10, post import S.02.01.01 data point C0010_R0050 will
show 44.

RUNNING IMPORT

1. Click “Select File” to locate the import file you wish to import.

2. Once the file selection has been made and other import settings have been set as required, click
“Import”.

Note for table QRTs, the excel table object will be expanded to the required size depending on the number
of valid rows being imported; this does not need to be set up prior to importing.

Pre-import validation checks will be performed to ensure the import file is consistent with the chosen
specification. This check is performed at the row level, so rows not in the correct form for the import routine
to import will be omitted although the rest of the return will import correctly (note the rows not imported will
be listed in the import report).

The import report will provide feedback on the pre-import validations and provide progress updates to the
user on the processing.
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POST IMPORT REPORT

Following the completion of the import the import report window will show each data validation error within
the import file; providing the row number, data point (eg “Issuer name”) and the value.

This report can be filtered to remove information lines to only show the errors and can be copied into
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another application, send to the users default email client or printed:
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CSV
CSV or Comma-Separated Values is one of the data types supported by Tabular’s data import feature.

Here is an example of import configuration for CSV:

You can check the detailed process of importing in the Importing Data section.

Here’s a screenshot of the report after the import process:
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CSV Specifications
CSV file specifications are composed of:

1. QRT name – the name of the sheet where you wish to import the file.
2. Param
3. Data (number and text) separated by a comma.

Here’ s an example:

To create a file that allows you to import more than one QRT at once, replace the QRT Name (e.g.
S.06.03.01) with Book and chain together the standard import rows for the individual QRTs like this:

For each QRT, the default CSV specification can be replaced with a user-defined custom mapping. See
Custom Mapping section.
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XML
Schema

The specification for the XML import is the following schema:

Static QRT data points

Cell Address is the “full” EIOPA coordinate eg S.02.01.b _A26! for Deferred Tax Assets (Solvency II value)
in S.02.01 EIOPA code A26

Table QRT data points

Cell Address is the “full” EIOPA coordinate plus a row indicator eg S.06.02.b!_A8.345 for Issuer Name row
345 (QRT table row not excel row) in S.06.02.b EIOPA code A26.

Note the row number becomes a relative marker when Import Type selected is “Append”. Moreover,
missing row numbers in the XML file will result in blank rows in the QRT table.
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Excel
Here are the steps on how to import an Excel file:

1. Go to Import > Excel > Workbook

Currently, Excel has only workbook option for import.

2. Click Select File from the import task pane and locate your file.

3. Click Import

The import file in the example is S.06.03.01. By default, the Consolidate check box is selected for table
import. However, the user has the option to change it.

Live reporter shows the progress of the whole import process.
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XBRL Import
How to import XBRL
1. Click Import > XBRL in the ribbon.
2. Select whether to import in a Selected QRT or entire workbook.

3 The import taskpane will show with several configurable option :

4. Prior to importing, there are few boxes under QRT selection which you may ticked or not depending on
how you want your data to be imported.
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To learn more about all this configurations click here
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Structured file import
Tabular’s Structured File Import feature will automatically convert certain supported file types from the
original data structure, format etc into the EIOPA format.

Currently the following file types are supported:
- Clearwater S(E).06.02, S.07.01, S.08.01, S.08.02, S.09.01
- Royal London Asset Management S(E).06.02
- T4U S(E).06.02
- Lombard Odier

To use this feature please follow these steps:

1. Click import in the ribbon and select structured import file.

Note only the first sheet in the source Excel file being imported will be considered by this feature. If your
Excel workbook contains multiple sheets (eg S.06.02 and S.08.01 source data) these must be split into
different workbooks and imported separately.

2. Select the file and the type of file to import in the pop up screen.

The file type must be the correct version of the QRT eg select Clearwater S.06.02 is importing into S.06.02,
select Clearwater SE.06.02 for importing into SE.06.02
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Further, please note that the Expected header row first column Excel address in the file must match the cell
coordinate provided in the above window. If the first column header is not in that cell then the import
process may not work as expected.

3. Choose the consolidate or overwrite option.
Consolidate will append the data imported below any existing data. Overwrite will remove any existing data
and load the imported data from the first row in the Tabular QRT.

4. Once the above selections have been made click Import
The data should then be loaded into the relevant QRT worksheet(s). Note the import may load more than
one worksheet may be populated in the Tabular return eg Clearwater and RLAM files contain data for
S(E).06.02 table 1 and table 2 and both of these tables will be populated through the Tabular structured file
import process.

Note, for some files (eg Lombard Odier) the source Excel file can contain multiple sheets, but the sheet
names must be exactly the same as the QRT name in Tabular eg S.06.02.01.01 (S 06 02 01 01 as a sheet
name will not be processed)
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Database Connection
Not available in current release.
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Team
The Team section in the ribbon:

Export – allows user to “carve out” QRTs and share with other members. By this, any user that has access
permission can work on the same return.
Manager – provides user an option to “carve in” the exported QRTs.
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Team Export
To “carve out” a QRT, select Export in the Team section of the MS Excel ribbon:

Team File Export window will open:

Prior to exporting, all fields in the Export Settings are required particularly the user ownership. To do this
click the User drop down arrow:
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“Carve-out” is added to the file name and it can’t be removed. The file path can be changed by clicking the
Folder button.

The Sheet Configuration contains all QRTs in the return. You can select the QRTs that you want to export
by checking the corresponding boxes. Note that by default information, QRTs (S.01.01.01 and S.01.02.01)
are disabled:

Click Export at the bottom of the window. A dialogue box will then appear prompting you to the save the
changes before proceeding with the export process:

Live Reporter shows the export process:
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Once completed, the destination folder where the “Carve Out QRT” is saved will automatically open:

After exporting, check the “Carve Out QRT” for the following:

In the main workbook

1. Header of the “Carve Out QRT” is highlighted in red indicating it has been exported.
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2. The QRT is locked.

3. Edit Return is disabled in the ribbon.

4. In the File Export window, this QRT is disabled for Carve Out.

The exported QRT

1. Only the “Carve Out QRT” is copied. You can check this in the content page and the sheet tab at the
bottom.
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2. Formulas of the interaction are not copied unless the QRT referred to that formula is also included in the
carve out.

3. In the MS Excel Ribbon, Edit Return, Team, Consolidate, Custom VL and Upgrade options are
disabled.
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Manager
Located in the Team section of the MS Excel Ribbon, the Manager command provides the user an option to
“carve in” the exported QRTs.

All exported files are listed in the Active Team Files section. Once imported, it will be moved to Closed
Team Files section

To import back the file to the main workbook:

1. Click Action button and select Import from the drop down menu.

2. In the Team File Import window, choose your preferred import setting option:
Retain Team File means the “Carve Out” file will be kept after importing.
Delete Team File deletes the “Carve Out” file from where it was saved after importing.
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3. Select the corresponding check boxes to set import configuration.

4. Click Import button at bottom section of the window.

5. Live Reporter shows the progress of the import process

To close exported files:

1. Users have the option to set the file to “Closed” without importing by selecting the Close option from the
Action button drop down. Confirm this action by ticking the box in the Confirmation section.
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2. By default, Retain Team Files setting is selected, however you are able to change it.

3. Click the Close button.

4. Live Reporter window will show the progress of the process:

After all of the above steps are executed:

The “Carve Out QRT” in the main workbook is now unlocked but the sheet is protected. The special “carve
out” header is removed (red highlight on the QRT header), and the sheet Data Points are updated
depending on the sheet configuration applied.
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Workflow
Workflow refers to a progression of steps ( which can be a task or role) that comprises a work process. It
typically involves two or more individuals that add value, prepare, and review the worksheets of a
company’s Return.

Workflow helps users manage their time more efficiently and get more things done.

Users can see Workflow in the MS Excel Ribbon has 3 commands:

Click the sections below to see how each command works.
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Workflow Plan
The Workflow Plan Settings window contains all worksheets included in the Return. Each worksheet can
be assigned to a user for a certain task by either data preparation or review.

To assign roles and set deadlines, click Edit Task Plan button corresponding to the QRT.

The Edit window for the QRT opens up wherein users can set three things from this window:
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1.Task Owner pertains to the person assigned to prepare the data.

2. Review Owner is a person who evaluates the data.

Roles can be set by clicking the drop down menu. Note that the Task Owner and Review Owner cannot be
the same. Otherwise, the Save button will not be enabled.

3. Task Deadline refers to the time frame set as to the length (days) each task should take. This is always
set in Business days or Calendar days relative to Submission Date (reference point can be either the
submission or the reference period in the Return).

Note: The Review Deadline has to be either less than or equal to the Task Deadline, because review must
be accomplished first to ensure accurate data before the task submission.

Once all are set, click the Save button. A pop-up message “Task plan successfully saved” confirms that the
changes have been saved. You’ll then see in the Workflow Plan Settings window that both the Data
Preparation Owner and Sign-Off Owner have been set as well as the length of the task:
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The Workflow Plan Settings can be customised by clicking the settings icon in the upper right corner of the
window:

Users can change the Workflow Type, Reference Type, Days Type, and Submission Deadline on the
pop out menu.

Note that the Reference Type sets whether the due date within the workflow plan is associated with the
Reference Date of the Return or to the Submission Date.
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On the other hand, the Days Type sets whether the due date within the plan workflow plan is in Calendar
Days or Business Days.
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Workflow Status
The Workflow Status shows the progress of the worksheet with an assigned role. It provides information on
how much has been done so far and how much work is left to be completed.

To update the status of the task, you can click Edit Workflow button.

The Edit Workflow window will show the Current Status of the task, Percentage Completed, and Days to
Complete:

If you want to change the Current Status to In Progress, please click the “In Progress” button to indicate
that the assigned user is currently working on it.
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The assigned user may also adjust the percentage of the task completed by dragging the cursor to fill the
bar depending on how much of the task has been accomplished.

Once you are happy with the progress, click Save to update the changes.

As soon as the work is ready for review, click the Review In Progress button and the assigned user to this
role will work at this stage. When the review has been done, fill the percentage bar as to how much of the
review has been made by dragging the cursor.

In the above example, you will see that based on the review percentage completed, you are three days
ahead of the schedule. Click the Save button to update the changes.

In the Process Management window, you will see in QRT S.17.01.01 that the Overall QRT % Completed
progress bar is filled. It is now in Data Review process stage and waiting for the Process Owner’s action (
the one assign to the role set previously in the Workflow Plan Settings window).

Solvency II Solutions User Guide - 6.0.0.0

Page 126 of 365

http://www.manula.com/manuals/solvency-ii-solutions/tabular/1/en/topic/workflow-plan


The Scheduled Status column indicates how many days are left from the date of submission. There are two
colour indicators:

Green – shows ahead of schedule
Red – if you are behind schedule (filled at the left side of the bar) as shown in the picture:
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My Tasks
A user who is assigned to the data preparation may check the pending tasks in this section:

After clicking My Tasks the Task List pane will show on the left side of the worksheet:

You can drag to fill the progress bar on the right side to show how much data have been prepared. Save the
changes by clicking the “Check Mark” icon on the right.

You may also click the Edit the Workflow button to edit task details. Once you have no pending tasks, this
section will be empty.
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Tables
A table is a series of rows and columns in a worksheet. Using this structure, it allows you to analyse data
quickly and easily.

In the Return workbook,you can see this in list and part of hybrid QRTs respectively:
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Append Rows
Data can be manually added to table QRTs in the same way as that of the static QRTs. To add or remove
rows from the tables within the workbook, you can use the buttons available in the “Table” section of the
Tabular ribbon.

Append single row
To append a single row to a list within the SII workbook click “Append Row”

Append multiple row
To append multiple rows to a list within the SII workbook click “Append Multi”
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Delete Rows
Remove row(s)

A user can delete one or more rows from a list within the SII workbook. To do this, select the rows you wish
to remove and click “Delete Selected” from tabular section in the ribbon.
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Validations
To validate return data at any point in time, select whether you wish to validate the full return or just a
selected QRT. You can also see all validation results or just those with errors:

The validation processing report will show an update report as to the progress in the production.
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Validation Report
The validation report will display the selected set of results, with the cell being tested, of the actual and
expected results plus a description of the test itself. The source of the validation is also indicated.

There are three different sources of validations and they are: EIOPA, XBRL taxonomy and Solvency II
Solutions validations. Users can also add custom validations such as below:

For any error cells, the error text in the Result column can be clicked to quickly navigate to the error cell:

The validation report can also be easily navigated through the right click menu:
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Drill down

The target cell of a validation can be easily navigated using the drill down function within the validation
report. You can right click in the expected value column of the validation row and choose drill down from the
menu as normal:
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Validation Error Types
Blocking and Non-blocking – represents the severity property from the EIOPA xbrl validations settings. It
should match the category of error that you would see in regulator portal validations.

*NCA Plausibility * – represents a Plausibility check that is performed by your local NCA (regulator) e.g. if
you are an Irish authorised insurer, any Central Bank of Ireland Plausibility test that is loaded into Tabular
and fails against your data, the result will be ‘NCA Plausibility ‘.

*Other NCA Plausibility * – represents a Plausibility check that is performed by an NCA other than your local
NCA eg if you are a UK authorised insurer, if a Central Bank of Ireland Plausibility test that is loaded into
Tabular and fails against your data, the result will be ‘Other NCA Plausibility’.

SIIS warning – any other tests in the validations that are not in the above four categories (i.e. regulator
specified in some way) i.e. tests that we have added (from reviewing LOGS, annotated templates, Q&A etc.)
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Validation Comments
Add new comment to validation result

Users can add comments to validation results which will be saved in the database against the return and
validation ID.
To add a note select the validation result you wish to add a note to and click Comments > Add/edit
Comment in Validation section of ribbon:

Then add Subject of comment and Description.

User also can select to Hide validation from results, and, if so, Auto-unhide, more detailed information about
it here.

It is possible to add one comment to several validation results at the same time, user should select all
needed validation results and click Comments > Add/edit Comment. The entered comment will be
assigned to all those selected validation results.
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The comment will now be displayed in the Comments section for a specific validation ID each time the
validation is reported:

For each validation comment the Actual and Expected values (from the validation report at the time the
comment is added) are displayed, as well as time and user it was submitted by.

Edit comment

Users can edit validation comments. To edit comment user should select existing comment that should be
changed and click Comments > Add/edit Comment

It is also possible to edit several comments to different validation results at the same time, user should
select all comments that should be changed and click Comments > Add/edit Comment. All selected
comments will be edited and changed to same new comment.

Delete comment

Users can delete validation comments. To delete comment, user should select existing comment that should
be deleted and click Comments > Delete Comment
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It is also possible to delete several comments to validation results at the same time, user should select all
comments that should be deleted and click Comments > Delete Comment. All selected comments will be
deleted.

Re-Affirm comment

When the underlying values for validation have been updated (the actual value and/or the expected value),
since the validation report was run, the validation note cell will be highlighted in RED:

Users can then choose to Re-affirm the validation comment via the Comments drop down in the ribbon:

After this comment’s actual and expected results will be updated and it will be not highlighted anymore.

Copy-forward comment

In case comment exist for the same validation result (being the same: validation ID, eg BV123; QRT and
data point, eg S.06.02.01.01 C0040; and in the case of lists, the “RowIdentifier, eg ISIN/GB123456789) in
previous return, it will be displayed in Previous Return’s Comment column. It is read-only and can’t be
edited.
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Further, for cases where this comment is still relevant for current return’s validation result; users can just
copy-forward it to validation result in current return. User should select needed validation result and click
Comments > Copy-Forward Comment

Users can’t edit comments at the stage of copy-forwarding it, the only thing user can change at this stage is
to select or unselect Hide/Auto-unhide from results (more detailed information on it here. ). But comment
can be edited after it is copy-forwarded as a normal comment.

After a comment is copy-forwarded it is displayed in Comment column with Actual and Expected values of
current return.
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Hide/Auto-unhide validation result in report
Hide from results

It is possible to hide the validation results from the validation report.
To hide validation result user should add a comment to it and select ‘Hide from results’ checkbox.

Note: Hidden validation results will still be included in the validation report. However, they will be hidden
from view.

When the checkbox is selected this validation result will get status ‘Hidden by user’ and it will not be
displayed after the next validation report run.

Auto-unhide if any values change

Auto-unhide if any values change checkbox is enabled only in case ‘Hide from results’ checkbox is
selected too.
In case value of datapoint for this validation report was changed and Auto-unhide if any values change
checkbox was selected in comment, then validation result will be visible again and the comment will be
highlighted in RED. Status of validation result will be ‘Hidden by user but value changed’
User can Re-Affirm this comment, so comment will be updated and hidden again after the next validation
report run.

Note: If “Auto-unhide’ checkbox is not selected validation result will not be visible again after value change.
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Global configuration

Default settings of Hide/Auto-unhide validation result can setted up via Tools -> Settings -> System Options

So each time user will be adding new comments by default it will be created with default settings that were
set up there.
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Whitelist/Blacklist/Greylist rules setup
This feature allows users to automatically categorise validation results based on one or more rule
conditions, to be applied to the validation result fields. where those rule conditions are met, that validation
result will be marked with the assigned whitelist/blacklist/greylist result status. Those assigned whitelist
status will be automatically hidden from the validation report.

To open Tabular validation manager window click Manage button in the Validation section.

Tabular validation manager window.

Note: In case rule has multiple rule conditions and at least one of the conditions is not met, then this
validation result will be not flagged to this category.

New rule

To add new rule user should click the New Rule button and New rule window will open.
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Rule Name
Users can type any name up to 250 characters. Mandatory field.

Result category
Here the category of the rule Blacklist, Greylist or Whitelist is selected. Mandatory field.

Valid From/To
Here can be selected the period when this rule will be valid. Mandatory field.

Comments
Any comment on the rule. Non-mandatory field.

Rule conditions
Each rule should contain a rule condition. It is possible to add one or multiple rule conditions to the same
rule.
To add new rule user should click New rule condition button and new row for adding condition will be added.
There user should select Validation report field from the drop down.

Solvency II Solutions User Guide - 6.0.0.0

Page 143 of 365



And then select Condition function from the drop down.

Validation report field and Condition function are mandatory fields.

Condition function value is a free text field.
Each of these conditions can be deleted anytime. Just select the checkbox next to the condition and then
click the Delete selected button.

When all fields are filled user should click Save changes button and rule will be created and displayed in the
Tabular validation manager window.
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Each of this rules can be edited or deleted anytime. Just select the checkbox next to the rule and then click
Edit or Deleted button.

Note: Where the same validation result has more than one whitelist/blacklist/greylist rule applies and these
have different results types then the following hierarchy applies: Blacklist; Whitelist; Greylist.

Note: Whitelist/Blacklist/Greylist rules are only applied to failed validations. Validations that pass are not
assigned a whitelist/blacklist/greylist in the validation report. Such validation results would only be visible in
any case if the validation option ‘‘Show all results’‘ was selected.
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Output
The Output section in the ribbon has Export control:

Export command allows a user to produce output files of a selected QRT or the whole workbook.Type of
output files that can be exported are : Excel, CSV, XBRL and XML.

Printing can also be accessed in the Export menu:
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Export CSV
Users can export their Returns in CSV or Comma-Separated Values format, below are the steps:

1. Click Export in the ribbon.
2. Select CSV file type in the context menu.
3. Choose Selected QRT option to export data of a specific QRT or WORKBOOK to export the entire
Return.

4. The Export window shows the QRT or list of QRTs to be exported.(Note: you can deselect the ticked
boxes if you wish not to include some QRT for workbook export).

Then click export button.
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5. The export report window shows the progress of the whole process.Click OK once complete.

Using the QRT Navigator, you can quickly access the file and save yourself from browsing through the
main Return folder.
The CSV exported files are saved to a default folder named CSV Output Files located inside the main
Return folder like in the example shown below:
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Export Excel
Excel exported files have no Tabular custom properties. The sheets copied inside the new workbook will be
just like a normal Excel file when opened.

Creating Excel file:

1. Click Export > Excel > Selected QRT or Workbook to export a specific QRT or entire workbook to Excel.

2. The Export window shows, here you’ll see the QRT or list of QRTs to be exported.(Note: for workbook
export, you can deselect the ticked boxes if you wish not to include some QRT in the exported file).

Click export at bottom of the window

3. Wait for the live export report window to complete the process as shown here:
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Then click OK.

Locate your Excel exported file by clicking QRT Navigator button then select Your Excel Exports.
All Excel exported files are saved in Excel Output Files folder
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Export XBRL
XBRL (eXtensible Business Reporting Language) is a global standard reporting language used to define
and exchange financial information, such as financial statements.

To create an XBRL output file, simply export the data of the return to XBRL format:
1. In the ribbon click Export >XBRL
2. Select whether to export a selected QRT or whole workbook export.

3. The export report window provide progress updates to the user on the processing.

Click OK when its complete.
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Once exported, you can navigate directly to your XBRL files through QRT Navigator.

XBRL Structure:
Below is an example of an XBRL file

Note : where there are NSTs for xbrl output included in the return workbook (eg Ireland) then clicking XBRL
export > workbook will create multiple xbrl files; xbrl file for EIOPA templates and separate xbrl file(s) for
NST templates.
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Export XML
Extensible Markup Language (XML) is a markup language that defines a set of rules for encoding
documents in a format that is both human-readable and machine-readable.

XML Structure:
Below is an example of XML exported file which you can view using Notepad++

To create an output file in XML format:
1. Click Export >XML in the ribbon.
2. Select whether to export a selected QRT or whole workbook export.

3. Click export button of the export window that shows. (Note: the export window shows Single XML export,
therefore you only see one QRT in the list)
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4. The export report window shows the progress of the whole process. Once complete, click OK.

Locate your XML exports

Files exported to XML are saved to its default folder name XML Output Files.
Choose Your XML Exports from the QRT Navigator button of the MS Excel Ribbon and the folder opens:
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Export NST & SFCR
This section is for NSTs that are submitted in Excel format and for exporting the SFCR subset of templates
into a separate, more user friendly workbook.
To create an NST & SFCR export files, below are few simple steps to follow:
1. Click Export button in the ribbon >NST & SFCR as shown below.

2. For SFCR reporting, multiple language versions of the SFCR output are supported ie SFCR export
(Slovenian language) will export the SFCR templates from the return workbook (ie P. and G. worksheets)
into the EIOPA designated template (eg P.02.01.02 will be exported to S.02.01.02 sheet) in the designated
language.

Solvency II Solutions User Guide - 6.0.0.0

Page 155 of 365



3. Once you have selected any of the options, a confirmed dialogue will appear. Click YES to zip file, NO
otherwise.

4. Exported files are saved inside the returns folder. Sample below:
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Non-ECB specific output
For clients within the Eurozone (or otherwise subject to the Solvency II “ECB Add-on” reporting
requirements) that are required to submit both ECB Add-on output and non-ECB Add-on output; these two
feature can be used to create the non-ECB Add-on output files from a ECB Add-on return workbook.

For example, an qrs valid xbrl output file can be generated from a qes return workbook. Tabular
automatically converts (eg removes extra columns from SE.06.02 and applies all associated changes in the
file like filing indicators for S.06.02 instead of SE.06.02) the ECB Add-on QRTs and datapoints leaving a
valid non-ECB Add-on xbrl file that can be submitted to the regulator.
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Non-ECB Excel output

Use this feature to produce a standard Tabular Excel output file with the ECB Add-on QRTs converted to
their non-ECB Add-on equivalent. To the best of our knowledge this requirement is specific to Cyprus.
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Non-ECB XBRL output

Use this feature to produce the xbrl output file for the equivalent non-ECB entry point eg a ars file from a
aes entry point workbook.
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Print
Users can access the Print command in the ribbon as shown below:

Print Settings:

You can also customise the header and footer as well as other printing options here:

Printing selected QRT
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Printing workbook
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Audit
Audit is a tabular function that records and tracked every static data point changes, update in the return,
and activities of the user.

Audit Report creates a trail of recorded activities of the user.

Session Tracker keeps track of the individual changes as you moved from one data point to another.

The change report window appears at the bottom of the screen when Session tracker is clicked:

Every time you saved the changes the session tracker window will be emptied.
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Reference / Regulatory Hub
Regulatory Hub

To assist users in completing their Solvency II returns, our regulatory hub tool can be brought up to provide
all relevant guidance for any data point within the return, alongside the QRT so both can be in the same
view:

To open the Regulatory Hub, click the icon from the Reference section of the ribbon:

As you move from cell to cell the regulatory hub contents will update to show you the relevant guidance for
that cell. You can prevent the regulatory hub contents from updating (to stay fixed as you navigate around
the return) and also directly query the full regulatory hub library. See Auto-update and Full library search
sections.

Expand/ Collapse Per Regulatory Source Text

The guidance is grouped by the source text, and these can be expanded or collapsed as required.
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This is how it looks like when all source texts are collapsed:

When Solvency II Directives guidelines entries are expanded:

Each entry is limited to a certain height by default, but if you see the scroll bar in the bottom right, it means
that there are other texts hidden from view. The regulatory hub entry can be expanded by clicking on it:
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Filter by Regulatory Source Text

To only show entries within the regulatory hub list from a particular source text use the drop down menu
above the list:

Search Within Regulatory Source Text

To find text within the regulatory hub entries displayed, type in the search textbox above the list of entries:
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Auto Update

By default the regulatory hub contents will automatically update on each change of the active cell. However,
you can disable this feature by selecting “Turn off automatic refresh” at the foot of the list:

Click the “Refresh” button to update the contents of the regulatory hub.

Full Library Search

To search the full regulatory hub library directly, select “Full Library” checkbox next to the search box:

This will clear the contents of the list. To search the full library next select a source text from the drop down
and enter the search term requested:
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The list will display all regulatory hub database entries which include the search term requested:

Adding User Notes to Regulatory Hub Entries

Users can add their own notes to any regulatory hub entry, which will be saved to the database and
presented whenever that regulatory hub entry is shown.

To add a note, right-click in the regulatory hub item you wish to add note to:

Then, complete the add comment pane:

Solvency II Solutions User Guide - 6.0.0.0

Page 167 of 365



The comment is now added to the regulatory hub item:

Favourites

Reg hub items can be added to the favourites library by right clicking on the item and selecting “Add to
favourites”:

Users can select to add a favourite as a personal favourite or a global favourite :
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If Yes, the selected entry will be a global favourite.

If No is selected, then that entry will be a personal favourite. Which means selecting “My favourites only”
button will show only those favourites added by the user as a personal favourite:

You can identify favourites easily because of the gold star in the top right of the reg hub item:

Showing Only Favourites

To only show favourite items in reg hub, a user can select the star icon in the bottom right of the task pane:
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To see all favourite items, not just those favourite items for the current data point, you can select “Show all
favourite items” and the reg hub list will populate with every reg hub items which has been tagged as a
favourite but not limited to the reg hub items which are relevant for the current data point.
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Notes and Procedure Notes
There are two notes-based features: Notes and Procedure Notes.

Notes
New Notes feature allows user to add notes against any QRT in a return and assign these notes to other
users, with given priorities etc. Restrictions can be placed on which users have the authority to resolve
specific notes. Further, threaded comments can also be added against each note and an audit trail of all
changes for each note is held.

Procedure Notes
New checklist feature is similar to notes but allows users to instead create “template tasks” to be performed
in each return, subject to the conditions assigned to the template task. For example, a recurring task
(assigned to any return with S.06.02.01.01 or SE.06.02.16.01 QRT included) to check and remove if
necessary any negative investments
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Add Note
Create new note button is available in the Sign-off section of the Tabular ribbon.

Note: It can be opened from return workbook but disabled from Tabular.xlsm
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QRT
This dropdown contains all returns that are presented in the current return.
This is a mandatory field, so the Create note button is disabled until a QRT is selected.

For resolution in process stage
Leave the above as Unassigned to allow the note to be resolved at any stage before QRT Sign-off.
Otherwise, if you wish to specify at which specific stage within QRTSign-Off (ie Input or Review) the Note
must be resolved before that stage can be completed then assign to one of those options.
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Internal only
It will be possible to export all notes into an output file that can be shared with internal or external audits. In
case ‘internal only’ is selected it will not include this note in output file for external parties. And vice-versa, if
in Internal only ‘No’ will be selected – this note will be added to this output file.

Summary
It is possible to input up to 250 characters.

Priority
It is possible to select priority from the dropdown: Low, Medium, High. It is only used for MI purposes and by
default Medium is selected.

Assignee
An optional field, by default Unassigned is selected. It is possible to select any active user from dropdown.
Note: Unassigned notes can be resolved by all active users, but if a note is assigned to some user, then
only that user and user with NoteAdminitrator role can resolve it.

Description
User can set font, color and size of text. Also, it is possible to mention users, add file and web links.
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Show All Notes
Show All Notes button is available in the Sign-off section of Tabular ribbon.

This window shows all Notes (and associated comments) for the current return.

There is Edit button next to each note that opens Edit window. More information on editing note is here.

Show All Notes window contains all information on each Note and it’s status. By default it includes
‘Resolved’ notes, but these can be hidden using the ‘Hide Resolved Notes’ button.
To Resolve a note(s), select the checkbox(es) in the ‘Resolved’ column for the note(s) and click Confirm
resolving of selected Notes. Thus, if many checkboxes are selected then all selected notes can be
Resolved at the same time.

Note: The ‘Resolve’ checkbox for a note will be disabled for unresolved notes where the note is either
assigned to a different user (and the current user does not have the NoteAdministartor role). User with
NoteAdministrator role can resolve any Note, no matter who is assignee or author of the note.

Note: Also it is possible to Unresolve notes, but it could be done only from the Edit Note window. Here
more information.
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Edit Note
Edit note button is available for each note in the Show all notes window and opens the Edit Note window as
below:

Editing by Author of the Note
Author of the note can edit it at any stage until it is resolved. All fields can be edited. Only Reporter and
Created are read-only.

Note: Summary and Description can be edited by clicking Edit button below each of these fields. After this
Summary and Description can be edited and will be saved after clicking Save button.
Changes in all other fields are autosaved.

There are restrictions on what information, and who has the privileges, can be edited for a note:
Editing by Assignee of the Note
Assignee can only reassign note to another user or make it unassigned. All other fields are disabled for
editing.

Editing when current user is nor Assignee and doesn’t have NoteAdministrator role.
In this case user can’t edit anything, all fields are disabled for editing.
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The only thing that can be added to note by all users and at any stage is Comments.
Adding Comments to Note is a useful way to record additional detail about an issue, and collaborate with
other users. Comments are shown in the Comments tab of the Activity section.

To add a comment type it in the Comment text box using as many lines as you require and click Save.
Existing comments can be modified or deleted only by their original author.

Using the History tab in Activity section, you can see the recent changes made to note.
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Unresolve Note
Resolving a note takes place in the Show all notes window. However, unresolving a note only takes place
within the Edit note window.
In case user wants to unresolve note, he should click Edit button next to the note. Special section at the top
of the edit window will be presented.

Once the note was resolved you can edit again according to the previous instructions.
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Add Procedure Note
Create new procedure note button is available from Show All Procedure Notes window in the Sign-off
section of the Tabular ribbon.

Note: It can be opened from return workbook but disabled from Tabular.xlsm
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Applicable Company(ies)
This dropdown contains all possible Companies.
This is not a mandatory field. It is possible to select none, one or several companies at the same time.
In case none of companies will be selected, this procedure note will be relevant for all companies. And if
some companies will be selected, then this procedure note will be relevant only for these companies.

Applicable QRT and/or QRTRoot(s)
This field is mandatory.
Dropdown with list of possible QRTs and QRTRoots appears after the first characters are entered.
It is possible to select one or several QRTs or QRTRoots at the same time. Procedure note will be relevant
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only for selected QRTs or QRTRoots.

For resolution in process stage
Leave the above as Unassigned to allow the note to be resolved at any stage before QRT Sign-off.
Otherwise, if you wish to specify at which specific stage within QRTSign-Off (ie Input or Review) the Note
must be resolved before that stage can be completed then assign to one of those options.

Applicable returns (by reference dates)
Here the dates in which this procedure note will be valid can be chosen. Procedure note will be relevant for
the return only if reference dates of return match the valid From/To dates of procedure note.

Summary
It is possible to input up to 250 characters.

Priority
It is possible to select priority from the dropdown: Low, Medium, High. It is only used for MI purposes and by
default Medium is selected.

Assignee
An optional field, by default Unassigned is selected. It is possible to select any active user from dropdown.
Note: Unassigned notes can be resolved by all active users, but if a note is assigned to some user, then
only that user and user with ProcedureNotesAdministrator role can resolve it.

Description
User can set font, color and size of text. Also, it is possible to mention users, add file and web links.
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Edit Procedure Note Template
Edit procedure note template button is available for each procedure note in the Show all Procedure Notes
window and opens the Edit Procedure Note window as below:

Any user can edit procedure note template at any stage. All fields can be edited, except Reporter, Created
on, Last updated by and Last updated on fields that are read-only.
Note: Applicable Company(ies), Applicable QRT and/or QRTRoot(s), Summary and Description can
be edited by clicking Edit button below each of these fields. After these fields can be edited and will be
saved after clicking Save button.
Changes in all other fields are autosaved.

Adding Comments to Note is a useful way to record additional detail about an issue, and collaborate with
other users. Comments are shown in the Comments tab of the Activity section.
Note: These comments are only visible in the Procedure notes section, they will not be visible in Checklist
section.
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To add a comment type it in the Comment text box using as many lines as you require and click Save.
Existing comments can be modified or deleted only by their original author.

Using the History tab in Activity section, you can see the recent changes made to note.

De-activate template note
Each procedure note template can be de-activated by clicking on ‘De-activate template note’ checkbox in
Edit Procedure note window.
There are no restrictions on which users can de-activate procedure note templates.

Note: Once the note template is de-activated this note will no longer be available in return checklists
EXCEPT in the case where this checklist item has already been “actioned” (ie its status has been changed
and/or a comment has been made against the checklist item), in which cases the checklist item will remain
in the return’s checklist
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De-activated note templates can be activated again by unchecking ‘De-activate template note’ checkbox. As
weel, there are no restrictions on which users can activate procedure note templates.
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Checklist
Show All Checklist button is available in the Sign-off section of Tabular ribbon.

Note: This window show procedure notes templates that are filtered out via QRTs, Companies and valid
From/To dates and only those that meet all requirements for current return are displayed in checklist
window.

There is Edit button next to each checklist item that opens Edit window. More information on editing
checklist item is here.

Show All Checklist window contains all information on each Checklist item and it’s status. By default it
includes ‘Resolved’ checklist items, but these can be hidden using the ‘Hide Resolved Checklist’ button.
To Resolve a checklist item(s), select the checkbox(es) in the ‘Resolved’ column for the note(s) and click
Confirm resolving of selected Checklist items. Thus, if many checkboxes are selected then all selected
checklist items can be Resolved at the same time.

Note: The ‘Resolve’ checkbox for a checklist item will be disabled for unresolved notes where the note is
either assigned to a different user (and the current user does not have the ProcedureNoteAdministartor
role). User with ProcedureNoteAdministrator role can resolve any Checklist item, no matter who is assignee
or author of the checklist item.

Note: Also it is possible to Unresolve checklist item, but it could be done only from the Edit Checklist item
window. Here more information.
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Edit Checklist item
Edit checklist item button is available for each checklist item in the Show all checklist window and opens the
Edit Checklist window as below:

The only thing that can be added to checklist by all users and at any stage is Comments.

Note: All other fields are read-only.

Adding Comments to Checklist item is a useful way to record additional detail about an issue, and
collaborate with other users. Comments are shown in the Comments tab of the Activity section.
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To add a comment type it in the Comment text box using as many lines as you require and click Save.
Existing comments can be modified or deleted only by their original author.

Using the History tab in Activity section, you can see the recent changes made to checklist item.

Unresolve Checklist Item
Resolving a checklist item takes place in the Show all Checklist window. However, unresolving a checklist
item only takes place within the Edit Checklist window.
In case user wants to unresolve checklist item, he should click Edit button next to the checklist item. Special
section at the top of the edit window will be presented.

Solvency II Solutions User Guide - 6.0.0.0

Page 187 of 365



Once the checklist item was resolved you can edit again according to the previous instructions.
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Show All Procedure Notes
Show All Procedure Notes button is available in the Sign-off section of Tabular ribbon.

Note: This window shows all possible Procedure Notes (and associated comments), regardless of which
return is opened.

There is Edit button next to each procedure note template that opens Edit window. More information on
editing procedure note template is here.

Show All Procedure Notes window contains all information on each Procedure Note template and it’s status.
By default it includes Deactivated Procedure note templates, but these can be hidden using the ‘Hide
Deactivated Procedure note templates’ button.
Note: Deactivating and Activating Procedure Note Template can be done only from the Edit Procedure Note
window. Here more information.
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Malta ANST 08 A specific
How to include the ANT08 A and B NSTs in the annual return:
The new ANST08 (Underwriting/Binding agreements) templates are not currently covered by any of the
existing Tabular return setup options. Therefore, at present to include these NSTs in the Tabular return this
should be done via the QRT selection tab as ‘include override’ selection:

This can be done when creating new annual 31/12/2017 (or after) returns or editing an existing 31/12/2017
(or after) return.

How to populate the ANT08 A (via N.MT.08.01.01 AND N.MT.08.01.02):
ANST08_A is a special case where (due the specific layout of this NST in the MFSA Excel submission file)
the NST had to be split into two sub-sheets for Tabular to be able to support this NST.

In the MFSA Excel file ANST_08A is a single worksheet that uses merged cells to capture information at the
binding agreement level (coverholder name, agreement period, GWP etc.) but also at the sub-level of the
lines of business and outsourced activities covered by the agreement.

For example, the same binding agreement could cover three lines of business, and for each the
Underwriting; Claims Handling; and Distribution outsourced activity types could cover all three lines of
business. This would be presented in the MFSA template ANST08 as below:
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However, in Tabular, the use of merged cells in this way is not supported (and we think not advisable) so
this one-to-many relationship is structured across two worksheets: N.MT.08.01.01 and N.MT.08.01.02:

• N.MT.08.01.01 – the blue outlined sections above are entered into N.MT.08.01.01. For each binding
agreement (name of coverholder and period of agreement) there is one unique row in N.MT.08.01.01

• N.MT.08.01.02 – the orange outlined section above is entered into N.MT.08.01.02. For each binding
agreement (name of coverholder and period of agreement) add as many rows as required in
N.MT.08.01.02 to hold all of the lines of business and outsourced activity combinations (note the
MFSA limitations section below)

The same information represented in the MFSA output file would be entered into Tabular as below in sheets
N.MT.08.01.01 and N.MT.08.01.02:
- N.MT.08.01.01
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- N.MT.08.01.02

Note that the N.MT.08.01.02 C0010 and C0020 should match exactly with the N.MT.08.01.02 for Tabular to
link the two tables together.

MFSA limitations on ANT08 A:

Please note that in the MFSA output file they only support three lines of business by default per binding
agreement line of business. If you require more than three lines of business for any binding agreement line
of business then either:
- Contact us and we can modify the configuration data to support this
- Manually add this into the MFSA output file (first run the export to NST in Tabular and then insert a row in
the appropriate place in the MFSA ANST08_A worksheet
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Ways to collaborate in Tabular
Tabular is an Excel add-in and as such it has to comply to some limitations of Excel. One of them is that a
Tabular return can’t be opened by two users at the same time in edit mode- one will always be in “read only”
mode. In Tabular there are three main ways to create “copies” of the excel QRT files to allow different users
to work on different parts of the same return at the same time:

1. Export QRTs to Excel – creates another copy in Excel of the QRTs selected for export. This separate
Excel workbook can be accessed separately and then re-imported via Import > Excel function

Advantages: User who makes changes doesn’t need to have Tabular
Disadvantages: Can’t use any Tabular functionality like Validation, Reg hub etc..

2. Team carve-out functionality – creates a Tabular “sub-file” of QRTs selected for carve-out and in the
meantime locking them in main return. These separate Tabular return sub-files can be accessed separately
and then carved-back in via Team manager > Import . Details on how to use Team functionality you can find
here.

Advantages: You can use all Tabular functionality on the carved out QRTs -Validation, Reg Hub, Export
etc..
Disadvantages: Need Tabular to access carved out file

3. Copy the return workbook in Windows explorer – creates another exact copy of the return workbook
in your Windows explorer file structure. This workbook can be used for most Tabular functionality however is
not registered/ “offline” . You can then do any export from this copy and import into the main registered
return. You can check them in this help article

Advantages: Full copy of workbook with almost all functionality available
Disadvantages: Data Updates don’t update this copy, Users need to keep track of Tabular copies i.e. file
management, Need Tabular to access
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XBRL Introduction
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How Tabular Generates XBRL
XBRL is the required reporting format for Solvency II. Tabular allows you to convert your data from Excel
into XBRL automatically.

How Tabular generates an XBRL instance document :

The XBRL document can then be loaded into the regulators XBRL portal.
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XBRL Introduction
XBRL is a language that helps standardise the creation, sharing, and distribution of financial information. It
helps bring structure, a common understanding, and context so information can be easily interpreted and
compared.
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XBRL Glossary
Instance Document
XBRL File. A complete and full report as a single valid XBRL file. This can contain several or one Template
from a business perspective.
Should be UTF-8 encoded.

In pure technical terms an instance document could just be at a minimum :

• XBRL tags containing the document
• A reference to the taxonomy
• A single fact (possibly with a context)

Tuple
A set of facts that belong together. For example the Filing indicator is a individual fact and the container
element for the filing indicators hold all of the filing indicators is a Tuple.

Filing Indicators
This is a like an XBRL contents page of QRT Roots. This is a section in the XBRL document that essentially
describes overall contents (QRTs) of the XBRL document.

This is technically a reporting concept.
All QRTs that are exported will appear in the filing indicators section of the document.
Filing indicators are reported at the ‘root’ QRT level, not at the full QRT Name level.

Filing Indicator Elements
This is an individual reference to a QRT Root / Template.

Reporting Unit
A QRT Root or Template

QRT Root / Template / Reporting Unit
These 3 terms mean the same thing. An example of a root QRT is ‘S.06.02’
This is defined as 1 group of letters, dot, 1 group of numbers, dot, 1 group of numbers.
So S.06.02 is the root of S.06.02.02

This fits into the below hierarchy:

S.01 – TemplateGroup
S.01.01 – Template
S.01.01.01 – TemplateVariant (Appendix I: Quantitative reporting templates)
S.01.01.01.01 – BusinessTable (Content of the submission)
S.01.01.01.01 – AnnotatedTable (Content of the submission)
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Unit
Describes how the fact is measured. For example:

• monetary value in GBP
• monetary value in USD
• non-monetary value (must be used in combination with Data type and Decimals attribute to ascertain

the specific unit eg 2 d.p., 4 d.p. etc.)

Z Values
Dimension Member
The concrete value provided for a dimension. For example, for the line of business dimension, a dimension
member would be “motor business” or “property business”.

Explicit Member
Where there is a closed list of possible values for a dimension, this is known an explicit dimension. For
example, Country dimension (eg for country of authorisation fact) is an explicit dimension with finite list of all
country codes.

Type Member
Where a dimension can hold any value, this is known as a typed dimension. For example, the asset code
fact will hold an identifier for the asset which is not from a closed list.

Default Member
It is added to the file if the user / system does not select a value for a drop down / validation list

XBRL Fact
A fact holds the value for a cell but also includes all information to describe the cell:

• concepts (eg GWP)
• data type (eg monetary)
• descriptive dimensions (eg Motor business)
• entity (eg Insurance Company A)
• period (eg 31st December 2016)
• unit (eg 2 decimal places)

Reporting Fact
These are the data points from the QRTs generated. These must not be blank in any case. If they are blank
or zero, they will not be included / exported in the XBRL file.
(Reference: EIOPA XBRL Filing Rules – section IV )

Period
Periods in Solvency II XBRL are always an “Instant date” which equates to “Balance Sheet Date” (point in
time) in accounting terms.
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Dimension
A property of a reporting fact.It provides additional context to a fact.

Dimension Domain
Set of all members of a domain, grouped by business concept e.g. geographical areas. The geographical
areas domain lists all countries but also regions of countries (e.g. for reporting natural catastrophe
exposures to Western Europe)

Context
A collection of descriptive terms (dimensions) that can be shared across a number of separate data points
(reporting facts).
Context is considered the same if the their descriptive dimensions are the same even if the ID of the context
is different.
An XBRL document should not contain redundant, non-used contexts
The ID can’t be the same for separate contexts.
Context IDs should be short and non-descriptive.

Context Scenario
A container of custom dimensions. Segment and scenarios are similar, in this EIOPA taxonomy we only use
scenarios.
The purpose is simply to contain the elements within.

The scenario must contain one or more explicit dimension or typed dimension and no other element.

XBRL Producer
The Code Engine that generates the XBRL file

LEI
Legal Entity Identifier. You must use a LEI that you have received from a LEI issuer. If you don’t have one,
you can use a local code given to you by your regulator.

Specific Codes
Local Codes (non LEI codes).
If your local regulatory requires something other than an LEI code, you can easily access it in the code type
dropdown. Then, choose ‘Local Code’ when creating a return.

Reporting Entity
A company or a group of companies which are required to report Solvency II number to their regulator.

Reporting Currency
The reporting currency is the currency selected by the user on the first company creation screen. It should
be the currency that the insurer uses to prepare their statutory accounts. Generally, all monetary items are
reported in the reporting currency, but in the following cases use the original currency:
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Original Currency
The currency of the monetary item as it is originally denominated.

Enumerations
This section explains certain enumeration scenarios , for example Currency Code.

Currency / Country Code
The code that represents the currency which is used in the XBRL instance document. This should be the
ISO code coupled with the currency code, for example ISO4217:GBP. If the currency is in the context
element, it will be represented as a dimension member: s2c_CU:EUR, or as an enumeration like this:
s2c_CU:GBP

The Solvency II Taxonomy
This is the specification to which your XBRL instance document will meet. It is effectively a description of
exactly how the document should be constructed from the data points you enter in Tabular.

T4U Application
A test application provided by EIOPA for testing the production and consumption of XBRL instance
documents.

Solvency II Solutions User Guide - 6.0.0.0

Page 201 of 365



Taxonomy
Business Term
Rule Book and Specifications

Description
Collection of definitions of reporting concepts, relationships between them, and various resources
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Instance Document
Business Term
Submission Document (Filing / XBRL Report)

Description
Contains reporting facts that are based on metadata defined in the taxonomy.
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Reporting Fact/ Fact
Business Term
Data Point (A Cell in a QRT)

Description
A fact that holds the value for a cell but also includes all information to describe the cell such as:

• concepts (e.g. GWP)
• data type (e.g. monetary)
• descriptive dimensions (e.g. Motor business)
• entity (e.g. Insurance Company A)
• period (e.g. 31st December 2016)
• unit (e.g. 2 decimal places)
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Context
Business Term
Grouped information that supports similar data points

Description
Contains dimensional information related to a fact. Contexts can be shared between facts, e.g. instead of
repeating all data points relating to Motor business, it will refer to a context which specifies the line of
business.
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Unit
Business Term
Unit of a data point

Description
Describes how the fact is measured. For example:

• monetary value in GBP
• monetary value in USD
• non-monetary value (must be used in combination with Data type and Decimals attribute to ascertain

the specific unit eg 2 d.p., 4 d.p. etc.)
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Reporting Entity / Entity
Business Term
Company ID (LEI / Local Registration Number)

Description
Provides identification of the reporting entity in the classification of a specific regulator e.g. can be LEI or in
some cases the regulator requires a local registration number to be used to identify the insurer in the XBRL
e.g. CBI in Ireland.
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Period
Business Term
Year-end date/ quarter-end date

Description
Periods in Solvency II XBRL are always an “Instant date” which equates to “Balance Sheet Date” (point in
time) in accounting terms.
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Dimension
Business Term
Line of business, valuation method

Description
Dimension is a property of a reporting fact e.g. line of business dimension or valuation method dimension.
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Dimensional analysis
Business Term

Description
The set of reporting facts can be identified based on values of a specific dimension:

• Primary dimensions – entity, period, unit
• Custom dimensions – specific concepts (typed and explicit)
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Dimension Member
Business Term
Motor business
IFRS
ISIN/US54374324

Description
The concrete value provided for a dimension. For example, for the line of business dimension, a dimension
member would be “motor business” or “property business”.
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Explicit dimensions
Business Term
Line of business
Country

Description
Where there is a closed list of possible values for a dimension, this is known an explicit dimension. For
example, Country dimension (e.g. for country of authorisation fact) is an explicit dimension with a finite list
of all country codes.
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Typed dimensions
Business Term
Asset code
Identifier code

Description
Where a dimension can hold any value, this is known as a typed dimension. For example the asset code
fact will hold an identifier for the asset which is not from a closed list.

Solvency II Solutions User Guide - 6.0.0.0

Page 213 of 365



Enumerations
Business Term
Issuer Country
Type of asset code

Description
Where there is a closed list of possible values for a fact value, this is known as an enumeration. For
example, Issuer Country fact can only have a value within a finite list of country codes
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Dimension Domain
Business Term
Geographical areas

Description
The set of all members of a domain, grouped by business concept e.g. geographical areas. The
geographical areas domain lists all countries but also regions of countries (e.g. for reporting natural
catastrophe exposures to Western Europe)
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Reporting Concept
Business Term
GWP
Best estimate

Description
Each reporting fact must have one and only one concept.

Concept is the highest-level business descriptive part of a fact eg Best estimate.

A concept is usually not enough to completely describe the business terms, e.g. additional dimensions are
needed to specify that the fact relates to:

- Claims provision (or premium provision) of Best estimate and
- health line of business
- etc.

Technical note:
A concept is a template for a fact.
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Breaking Down An XBRL File
An XBRL file is a type of XML file that can be opened in a standard notepad programme (ideally with XML
formatting). It is human readable and can be analysed easily without any additional software.

Requirements of an XBRL filename

1. An XBRL should always have a file extension .xbrl (in lowercase)
2. Some regulators require a specific naming convension of the filename.

Anatomy of an XBRL File
The rest of this section explains the various section of an XBRL file and where you can find the various
components. e.g. insurance company name, the value of a data point, reporting period etc.

The first two slides show the basic anatomy of an XBRL document, followed by definitions of the
components contained in the document below the two slides.
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In the above picture you will see references to the elements in the XBRL document :

Context
(Each context is dynamic and the unique collection of dimensional descriptors for reporting facts).
All facts that require this specific collection of dimensional descriptors will refer to this context via the
contextRef property of the reporting fact
Note: order of contexts and order of content within contexts is irrelevant

Entity
Entity is static. Its context includes the entity tag (company identifier)

Period
This is static – every context includes the period tag (return reference date)

Scenario
Considered as dynamic, all other dimensions to describe the reporting fact are stored in the scenario.
Note: A context does need a scenario (i.e. fact may be described by entity and period alone scenario must
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not be blank if present.

Reporting fact
Dynamic (every data point – which is not part of a list key) will have its reporting fact line except for
monetary facts which are 0 or empty in the return.
The reporting fact is the value of the data point.

Reporting concept
Every reporting fact has one and only one concept.
The data points in the return are linked to reporting concepts in Tabular using XML MAP files. A reporting
concept can be viewed in the taxonomy the metric name space.

ContextRef
Every reporting fact has to have a ContextRef property
This refers to the specific context for the reporting fact which holds the relevant dimensional descriptors

UnitRef
This refers to a unitref context which defines whether reporting is monetary or non-monetary if numeric
Note: mandatory for numeric facts and must not be present for non-numeric facts

Decimals
This specifies the data precision.The data precision depends on the data type LINK TO MAPPING OF DATA
TYPES TO DATA PRECISION IN DOCUMENTATION
Note: mandatory for numeric facts and must not be present for non-numeric facts

The slides below show how a QRT in Excel is represented in XBRL exported file:
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XBRL Technical Implementation
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XBRL Data Points
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Duplicate Data Points
Duplicate Datapoints

An XBRL output file should never contain the same (identical value and business descriptors) fact more
than once in any given document.
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Inconsistent Data Points
Inconsistent Datapoints
We can’t have the same data point in two places with different values, data precision or language.

For example:
S.23.01 – SCR data point.
S.28.01 – SCR data point

These two datapoints are effectively the same fact in XBRL terms, so the value, precision and language
must be the same. Language is not user defined so this is not a consideration. The data precision is
enforced by the QRT so this is also not driven by the user. The value is user driven and therefore can be
different.

Currently Tabular will take the FIRST value it finds in all cases and include this in the XBRL output.

In all such possible cases we will have a Validation within the Tabular validation report that will point out
this scenario to the user.
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Important Data Rules
• Zero is considered blank and not exported.

• Some data points get combined.

• % are to 4 decimal places

• Dates are always formatted in YYYY-MM-DD (ISO 8601 – https://en.wikipedia.org/wiki/ISO_8601),
exactly the same as the workbook format
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Numeric Formats
There are specific rules in the Taxonomy about data precision for numeric values being submitted in XBRL.

The below tables summarises all the Numeric types used in Tabular together with some business examples
and the metric.

The number of decimal places mentioned in the table above is placed on Decimal property. All numeric data
types use the Decimal property in the output XBRL file. This property is driven by the datatype.

More details below on how our XBRL generation processes this number format.

Integers – 0 decimal places in the Tabular template and no XBRL transformation.

Percentages – are handled in Tabular as 4 decimal places in the specific cell that is a percentage.
So 9 % should be represented by the user as 0.0900. There as 2 decimal places for the percentages, so
9.33% inputted into the system as 0.0933 is also valid.

No XBRL transformation takes place and the percentage is reported in this 4 decimal place format.
Insignificant zeros are kept in the XBRL output. An example of a percentage with insignificant zero is 1.0000
– which represents 100% with two insignificant zeros.
Percentage can be over 100% or 1.0000 for example a 250% capital adequacy ratio.

Rates (Quantity / Duration) – 1 decimal places in the Tabular template and no XBRL transformation

Monetary values (In general) – 0 decimal places in the Tabular template and no XBRL transformation

Monetary Values (specific exception list ) – 2 decimal places in the Tabular template and no XBRL
transformation. These templates are part of the exception list S.06.02, SE.06.02, S.08.01, S.08.02, S.11.01
and E.01.01. The list of data points that are affected are below:

Monetary Data Points
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Scaling of Numeric Values
You can’t scale numeric values for your XBRL submission. A Numeric fact must be expressed in units
specified. For example, you can’t report in thousands or millions of units.

Reference document: Section 3.3
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XBRL The Submission
How to open an XBRL File
If you need to troubleshoot an XBRL file prior to submission, we recommend that you don’t open the file in
notepad, use a text editor with XML formatting support to view the file in a viewable format.

Submission
The submission should be only 1 XBRL file for your main return excluding NSTs (assuming no XBRL
streaming, which currently is not supported byTabular). ( Reference EIOPA XBRL Filing Rules III.4 Section
completion of the instance document ). For test purposes, it is ok to submit an individual QRT to your
regulator portal. There should be a flag available in the portal to alert the consumer of this being a test
rather than final submission.
If you need to re-submit your filing due to an error, you need to resubmit the entire file, not just the corrected
part.

National Specific Templates (NSTs)
These are national specific requirements of a local regulator. They may also need to be generated into
XBRL depending on the Regulator. These documents have a separate entry point and so therefore should
be created in a separate file.

Structure of Regulators
We generate an XBRL to submit to a regulator. The flow of information follows the below path

1) Main XBRL file (Every template that is not an NST) -> Submitted to Local country regulator. Local country
regulator passes on the file to EIOPA (the Central European Regulator)

2) The NST XBRL file gets submitted to the regulator and stays with the local regulator.
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XBRL List QRTs
Some QRTs are open list and need to be handled in XBRL in a specific way. In the business table there
might be 10 columns, 6 may be reported and the remaining 4 form the context of the remaining 6.

You can view the List QRTs and the data that forms the table key (non reportable descriptors) here

Some business tables / List QRTs are linked through a forien key, for example S.06.02 has two tables that
form a TemplateVariant

• S.06.02.01.01 has 4 elements to the key: Asset ID, Asset ID Type, Matching Portfolio Number, Fund
Number

• S.06.02.01.02 has 1 element in the key: Asset ID, Asset ID Type

Every element in S.06.02.01.01 with the same asset ID will share the same information on that asset that is
held in both list QRTs.
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Reportable Columns
Some columns are NOT reportable facts, they are part of the context / descriptive element that supports
other reportable facts. These items are always part of the table key, however, they can be blank. As long as
two rows do not have the same data in the key (including blanks) the data is valid.
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Table of List QRT Datapoints
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Foreign Key Relationships
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Line Identifier
On some list, QRTs have additional key of line identifier. This is not visible in the QRT and enable multiple
lines of what seems to be the same data to be exported.

List QRT with line identification:

S.06.02.01.01
S.06.02.04.01
S.06.02.07.01
SE.06.02.16.01
SE.06.02.18.01
S.08.01.01.01
S.08.01.04.01
S.08.02.01.01
S.08.02.04.01
S.09.01.01.01
S.09.01.04.01
S.06.03.01.01
S.06.03.04.01
S.10.01.01.01
S.10.01.04.01
S.11.01.01.01
S.11.01.04.01
S.14.01.01.01
S.07.01.01.01
S.07.01.04.01
S.02.03.07.03
S.31.02.01.01
S.23.04.04.10
E.01.01.16.01

None of data points form part of the key, only a code (from the annotated template and not visible in the
QRT) forms the key:

S.01.02.07.03
S.11.01.04.02
S.23.04.01.01
S.23.04.01.02
S.23.04.01.03
S.23.04.01.04
S.23.04.01.05
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S.23.04.01.06
S.23.04.04.01
S.23.04.04.02
S.23.04.04.03
S.23.04.04.04
S.23.04.04.05
S.23.04.04.06
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XBRL Filing Rules
Vendor Information in XBRL File

We include our vendor and product name and the version of the Tabular product that generated the XBRL
file in all output documents.
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XBRL Miscellaneous
Language Considerations

All dropdowns are converted into codes which are language independent

If you are filing in a specific language and the few text fields that are available in the application will not be
translated or converted and are filed with the regulator as is.

We do not add a language tag to any data points, so from an XBRL point of view it does not know the
language of the text.

There are some rules around which allows you to choose the language you can report to your local
regulator, however, any such rules are not implemented in XBRL and will be not considered / validated.
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XBRL Architecture Appendix
Below are some slides that could help you to understand some parts of the overall XBRL architecture. Some
of these concepts are used in the Solvency II Taxonomy.
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XBRL Support
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XBRL Support Documents
Annotated Templates Document
There is a supporting document that describes each QRT from an XBRL perspective. The document is
available here:

Reporting Format

Ensure you always download a fresh copy of this document before reviewing as EIOPA can at any time fix
issues in this document and upload it onto their website.

T4U Test Application
If you want to load your Tabular XBRL file or produce an XBRL file from the main EIOPA test application,
you can download T4U

T4U

Filing Rules
These are the rules an XBRL file must meet to be valid for submission. These rule complement the
Solvency II Taxonomy.

Filing Rules

DPM Dictionary
This is a diction of all objects from with the Solvency II Taxonomy

DPM

XBRL Test Files
If you would like to view some test files for comparison with Tabular XBRL files, you can download here.

EIOPA Test Files

Solvency II Validations
These are some of validations that Tabular implements prior to generating an XBRL instance document
(Tabular also implements may other internal / custom validations)

Validations
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XBRL Troubleshooting
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PRA
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FSC
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DMB
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CBI
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XBRL Appendix
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Table of list QRTs and Key Descriptors
List of datapoints and the data which forms the table key
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Consolidation
There are two inbuilt consolidation methods in Tabular:
- PCC consolidation
- Group consolidation
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PCC Consolidate
Use Tabular PCC consolidate feature to automatically populate the PCC aggregated entity based on PCC
cell and PCC core Tabular returns.

To begin:
1. click Consolidate > PCC Consolidation function in the ribbon.

2. The PCC Consolidation screen consist of 2 grids:

Return selection grid
This grid only shows all return with the same reference date and reference period type as the current return
(ie annual to annual, quarterly to quarterly etc) . Select the return to be consolidated in this grid.
QRT selection grid
In this grid, choose which QRT in the current workbook should be consolidated into. By default all QRTs are
included for consolidation, but user can filter the list by deselecting the checked box.
Then click run PCC consolidation button to proceed.

3. A confirmation message will show informing user that rows will be left but all static data will be lost.Click
yes to continue.
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4. Once the process is done, this message will be displayed.

The consolidated result varies depending on the type of QRT :
Static QRT – the value from the source workbook will be concatenated into the current return and formulas
will be replaced with the new calculated value.
List QRT – the consolidation process adds the same number of rows from the source workbook into the
current return and formulas like subtotals and interaction will not be replaced.
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Group Consolidate
Use Tabular group consolidate feature to automatically populate the group entity based on solo Tabular
returns.

To begin:
1. click Consolidate > Group Consolidate function in the ribbon.

2. The PCC Consolidation screen consist of 2 grids:

Return selection grid
This grid only shows all return with the same reference date and reference period type as the current return
(ie annual to annual, quarterly to quarterly etc) . Select the return to be consolidated in this grid.
QRT selection grid
In this grid, choose which QRT in the current workbook should be consolidated into. By default all QRTs are
included for consolidation, but user can filter the list by deselecting the checked box.
Then click Run Group consolidation button to proceed.

3. A confirmation message will show informing user that rows will be left but all static data will be lost. Click
yes to continue.
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4. Once the process is done, this message will be displayed.

5. The consolidated result varies depending on the type of QRT :
Static QRT – the value from the source workbook will be concatenated into the current return and formulas
will be replaced with the new calculated value.
List QRT – the consolidation process adds the same number of rows from the source workbook into the
current return and formulas like subtotals and interaction will not be replaced.

Limitations of Tabular group consolidation process:
The following QRTs are not populated from the solo returns due to technical reasons:
- S.02.02
- S.05.02

Also please note that group specific QRTs (eg S.32.01.04) where there is not a solo equivalent QRT (eg no
S.32.01.01 exists for solo returns) are not populated through the consolidation module.
For QRTs that are populated from the solo return, the following data points are not populated due to
technical reasons:
- S.01.03.04.01 c0010 – c0030
- S.31.01.04.01 c0010 – c0030
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Narrative Reporting
Narrative reporting is an add-in for Microsoft Word which enable the user to import relevant fields from the
QRTs and keep the quantitative disclosures within the qualitative reports in sync. It comes with a navigation
bar on the right hand side of the word document with different options. (see image)

Data Source Manager

Data Links

Chart or Table Object

Format Manager

Manage Fields
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Data Source Manager
This area identifies which data files are used for importing the data. It is important to understand that only
Excel fields that are Named Ranges can be imported into Word. The default file is the main QRT workbook
however users can import data from other Excel spreadsheets. Here’s how:
1. click Add File

2. enter name of source file and click ok.

3. Select the relative file /excel spreadsheet.

4. a pop-up message shows to confirm the file was added.

4. The file will be included in the drop-down list of the data source manager section.
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Data Links
In this section users can select the data points to insert as fields within the report.
QRTS can be selected via the drop down menu in the Worksheet field:

Data points can be selected via the drop down menu in the data point field:
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After selecting one data point users need to click on the “Insert” button to add that field to the text.
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Chart or Table Object
Tables and Charts are visual presentation. They permit rapid access to and relatively easy comparison of
information. Adding this graphic representation of data / value into the narrative report is simply easy.

1. Choose the source file in the data source manager drop-down. File not in the drop-down? click here

2. Select the type, worksheet and file name in the Chart or Table section of the narrative reporting tool.

3. Click insert button. The chart will be inserted into your report like shown here.

The drop-down are filter only if the sheet contains table or chart, otherwise it will show
empty.Note that it doesn’t take the actual table of the return but the one created by the user
(formatted with name range)
*
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Format Manager
As the entered fields cannot be formatted via the usual Word options, users have customize formatting
options in the Narrative Report navigator on the right hand side.

Once the field is selected the users can:
• Change the text formatting (if the field is text) – by selecting options from the Case field
• Add comma or dot for numeric figures
• Choose currency
• Choose colour
• Number of decimal places
• Bold/Underline/Thousands

For example, setting a value to be to 0 d.p.’s, £ and with comma thousands separator:
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Manage Fields
In the last section – “Manage Fields” – users have the option to:

• Refresh field – in case the figure in the QRT has changed
• Delete – delete the field
• Refresh all – refresh all the figures in the narrative reporting
• Lock – it stops a cell to be refreshed (either when Word is open or when the refresh all option is

selected)
• Unlock – unlock a locked cell
• Highlight all fields – this option allow the user to see all the imported fields in the text (as per the

picture below)

• Show field source: it shows the location of the field or the formula behind the calculation (as per the
picture below):
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Custom Fields
Tabular gives the option to ad custom calculations within the word document by using the options in the
“Calculated Fields” on the right.
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Siimplify
This feature allows you to add data from BW Solvency II Tool workbook into your return. Here’s how:

A. Configure the path where the BW Solvency II Tool workbook was placed.

1. Click Siimplify button in the ribbon and select Configure Siimplify workbook as shown in the image
below.

2. Navigate to the BW file in your drive and click open.

B. Run siimplify to insert the data from the BW workbook into the return’s workbook.

1. Click Siimplify button, select from the three option that applies: Cell, QRT or Workbook and click add
siimplify.

2. A message will appear that you are about to retrieve formulas from saved database, click Yes to confirm.
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3. Once done, this message will be displayed.

After running all the steps, your return will be filled with the formulas from the source file like the one below:
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Tools
Tools menu contains some tools that are not used on everyday basis but are helpful in a lot of situations.

Reset tool

This tool let you reset the dropdowns and format of the workbook. More info you can find in this article.

Recreate formulas tool

This tool works in a similar way as the replace subtotals and interactions option from the ribbon, but there is
a small difference. Clicking on the recreate formulas option will get both interactions and subtotals at the
same time from database, however it will not replace the formulas for any cell that have his formula
removed. It will only refresh existing formulas that are not removed by the user.

About

This opens a window that contains some useful information about current Tabular versions and the return
ID. More info you can find in this article.

Manage custom sheets

This option opens a window from where you can control adding/editing/deleting custom sheets in the
workbook. More info you can find in this article.
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Edit links

This option allows you to edit links to external workbooks. More info you can find in this article.

Export user data for support

This option creates a small zip file next to your Tabular.xlsm that contains some user data. Mostly company
and return setup etc.. This in some cases will be requested from SolvencyIISolutions support team when
they investigate an issue.

Attach log file to email

This option collects all the logs from Tabular, zips it and attach directly to a new email (if you have Microsoft
Outlook). Use this option to send logs to SolvencyIISupport team.

Apply Non- ECB transformations

This two options are needed for clients that have to report both ECB and Non-ECB variants of their data.
One of the options generates xbrl file – the other excel export file. More info you can find in these two
articles: Excel output ; XBRL output

Refresh H.HV sheet

This tool refresh the data in H.HV sheet that is used for roll forward. More info on it and roll forward in
general you can find in this article.

Auto-generate NIE13

This feature auto-generates the full NST.13 QRT data set (and loads this into the N.IE.13.01 QRT,
overwriting any existing data there) from the SE.06.02 return data. This feature implements all of the
exclusions, conversions, and aggregations outlined in the CBI ‘NST.13 Notes on compilation’ guidelines.

Analytics

This feature generates six dashboards and reports, all of which include trend analysis: Summary financial
report (key numbers from across each of the main Balance sheet, Own Funds, Technical account and
SCR/MCR QRTs); Investments dashboard, including look-through; Balance sheet and Own Funds
dashboard; Underwriting performance and Technical Provisions dashboard; SCR/MCR dashboard; and
Reinsurance program and recoverables dashboard.

QRT Sign-off manager

Sign-off feature allows users to lock-down QRTs that prevents any further changes (directly or via features
such as import) to the QRT.
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Manage custom sheets
Aside from the pre-defined sheets in tabular, user can add custom sheet(s) into the return workbook. Here’s
how:

1. Click Tools > Manage custom sheet

2. Manage your workbook custom sheet screen appears. Click Add custom sheet.

3. Fill the Sheet name and description field and click add button. (see picture above)
4. The sheet will be added to the workbook alongside the QRTs as shown here

Solvency II Solutions User Guide - 6.0.0.0

Page 266 of 365



Reset Tool
This tool give you the option to replace all your dropdowns with the latest values from the Database or
reapply the format of the cells. You can use this options if you have some QRT being corrupted. You can
apply this functionality on a cell, sheet or whole workbook level. Note that the replace Validation option will
add any dropdowns that are not existent at the moment in the workbook but they are in the database.
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About
Tabular consists of two parts – Application and main entry point(Tabular.xlsm + DB + helper files) with two
separate methods to update them. Sometimes just data update or application update is released and that is
why the versions don’t always match. In the About dialog you can check both versions:
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QRT Sign Off
The QRT Sign-off and UnSign-off are performed from QRT Sign-off manager:

Sign-off feature allows users to lock-down QRTs that prevents any further changes.
A single QRT or multiple QRTs can be Signed-Off at the same time.
To run Sign off, users just need to select QRT to be signed-off and click Save Sign Off changes button.
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After running Sign-off:
- QRT worksheet protection is set, so no changes allowed, directly or indirectly eg. import
- All formulas are removed from the sheet (Tabular formulas, user formulas and external link added by
users)
Note: All formulas are stored in the Tabular database and are re-loaded to the QRT worksheet if the user
UnSigns-off the QRT.

To UnSign-Off, users can select single or multiple QRTs and click Save Sign Off changes button.
All formulas (Tabular, user formulas, and external links ) will be loaded back exactly the same as they were
before sign-off and normal Tabular sheet protection will be set to this QRT worksheets.
Sign-off and unsign-off processes can be repeated as many times as necessary without any restrictions.
User could see information who signed-off/unsigned-off QRT and date/time it was done last time.

Unresolved Notes/Checklists
In case some unresolved notes or checklists exist for QRT, count of this notes/checklist will be displayed in
the Unresolved Notes or Unresolved Checklists columns next to QRT with red light background.
This QRTs still can be signed-off no restrictions on it. User can still SignOff QRTs even if they have
unresolved notes and/or checklists – we’re just providing this for information for now.

USER NOTES:
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• There is no verification or checking of re-loaded formulas to unsigned-off QRTs.
For example, if a user had a formula that was linked to an external workbook at the time of sign-off
and after that, this external workbook was deleted, on unsign-off, Tabular will load that formula back
in to the QRT ( which will go to the place that now doesn’t exist) – and Excel will resolve the formula
to a #REF! error.

• There are no checks that QRT being signed-off are linked to unsigned-off QRT.
For example, S.02.01 is signed-off, so it’s no longer linking to S.06.02, but S.06.02 is not signed-off,
so user could update values there. It probably will break some validations, because now there will be
different values in S.02.01 and S.06.02. At the moment Tabular will not flag to user that he needs to
sign-off S.06.02 before signing off S.02.01

• When user signed-off QRT it is not available for imports, but it is still available for exports eg. xbrl
export and in general all read-only access features, such as analytics, validations, etc.

• Access to QRT Sign-off feature can be configured per user.
This is available in user setup area; which you can find here System Admin > Administer users/Roles
> Assign access to role (more information here ) So if you have someone who should enter some data
but shouldn’t sign-off QRTs just unselect Sign-off role for him and he will not have access to Sign-off.
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Analytics report generator
Analytics output feature:

There are six dashboards and reports, all of which include trend analysis. User can include all reports or
filter generated report by selecting just some of the reports to be generated (note, if no of reports will be
selected Generate report button will be disabled).

CONFIGURATIONS
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Data Scope is selected by default and based on current return and can’t be modified ( in case current return
is annual then by default Data Scope Include annual return data will be selected), as well both couldn’t be
selected at the same time. Generally means, unless a quarterly reporting exemption is held, that
investments dashboard should be generated from quarterly return and SCR dashboard should be generated
from annual return.

Period scope Here user can select how many historical periods will be included in the report.

Output location folder of the generated report by default set to subfolder of the return, but can be changed
anytime.

After click on Generate button report will be generated as a separate workbook. Each time user generates
report a new output file is generated.

USER NOTES

• Charts in Excel 2010, NST and FSR data are currently not in scope
• Reports are a single-entity level (ie not group vs subsidiary allocation reports, PCC vs Cells/Core

reports)
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Analytic Reports
General:

• Charts will always tell you if the data is current returns’ data or trend report.
• Output file includes the “raw data” outputs from the Tabular database (which are the sources in the

analytic output file dashboards/reports).
◦ Name conversion of raw data sheets works like the first part of the name is QRTs which data is

included. For example, S.06.02.xx_augmntd means that it is data from S.06.02 (and xx means
that all S.06.02 QRTs are included).

• It is not available to modify charts, however you can create your own charts based on the same “raw
data” sheets by linking to these sheets from a separate Excel file.

There are six dashboards/reports currently supported:

Investments (dashboard)
Investments dashboard is sourced from S(E).06.02 and S.06.03, note other investments QRTs are currently
not in scope.

Underwriting performance and technical provisions (dashboard)
Split into Life and Non-Life lines of business reports.
These dashboards are sourced from S.05.01, S.12.01 and S.17.01 QRTs
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Summary financials (report)
Pulling key data from across each of the main Balance sheet, Own Funds, Technical account and
SCR/MCR QRTs.
There is ability to drill down into some of these sections (unhide next to the Excel data group icon).

Balance sheet and Own funds (dashboard)
This is sourced from S(E).02.01 and S.23.01 QRTs

Solvency II Solutions User Guide - 6.0.0.0

Page 275 of 365



SCR and MCR (dashboard)
This is sourced from S.23.01, S.25.01 and S.26’s QRTs. Note only Standard formula QRTs are currently
supported.
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Auto-generation of Central Bank of Ireland
NST 13
This feature auto-generates the full NST.13 QRT data set (and loads this into the N.IE.13.01 QRT,
overwriting any existing data there) from the SE.06.02 return data.

This feature implements all of the exclusions, conversions, and aggregations outlined in the CBI ‘NST.13
Notes on compilation’ guidelines but, as per those guidelines, there is a subset of scenarios where the
SE.06.02 data is incomplete, namely:
- the issuer country field for supranational issuers; and
- the issuer-sector field for ESA issuer sector codes 5,6,11 and another scenario where the ESA issuer
sector code is not populated in SE.06.02.

To support these cases, a data capture table is provided within the feature window for users to enter their
custom rules, please see this link.

Once all custom rules are added (and saved), or if no custom rules are required, click ‘Run NST.13
generation’ to run the feature.

NOTE: it is NOT mandatory to add any custom rules. You can run the feature with no custom rules but note
that in this case only the standard conversion will apply (for example if you have an asset, applicable for
NST.13, with issuer country ‘XA’, this country code will be used in the final N.IE.13.01 data set. Tabular xbrl
validations would then flag that ‘XA’ is not an allowed value for the NST.13 issuer country).
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Adding/Editing/Removing custom NST.13
rules
User will need to click on ‘New rule’ button and a new row will be added to rules with the ability to insert
data.
All fields, except Company, are mandatory and you will not be allowed to insert data to another new rule
until all of them will be filled.

Select Conversions Type:
‘NIE13_C0070’ for issuer country rules (ie deriving the NST.13 C0070 values)
‘NIE13_C0060’ for issuer sector rules (ie deriving the NST.13 C0060 values)

Company, If you have a multi-entity license and different rules should be applied in different Tabular entities
then complete the Company field to indicate a rule should be applied only to that company. Rules, where
the Company is left blank, will be applied to all companies the NST.13 feature is run on.

The ‘Set condition’ represents a SQL where condition, using SE.06.02 column names (eg. C0040, C0050
etc.) Please, use SQL wildcards and other conventions.
Note, do not add quotes (‘’) around the ‘Set Value’ and ‘Set condition’ fields.

‘Valid From’ and ‘Valid To’ must always be completed and indicate the return reference dates the rule is
applicable to.
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When all fields are filled user should Save changes and then click Run NST.13 generation. After this all
saved rules will be generated (note, not saved rules will be skipped)

There is also ability to delete rules. All you need to do is to select checkboxes next to rules that should be
deleted and click Delete selected rules.
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Retrieve timestamped return workbook
Retrieve timestamped return workbook is available in Tools section of the Tabular ribbon.

This window is used to retrieve the return workbook at any point-in-time it was saved by users.
For example, user wants to see the version of return at the time it was submitted.
Note: This will not affect current return. The requested timestamp version of the workbook will be saved in a
separate folder (selected in Output path)
Note: If the current return workbook is a Team carve-out, the list of savepoints will only include those for
this specific carve-out file. Conversely, the main return (from which carve-outs have been made) will include
savepoints of the main return only (it will not include savepoints of the carve-out workbooks)
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Return file savepoints
Here user can see all possible savepoints that can be selected to be retrieved. Each savepoint is displayed
with ID, date and time it was created, file path of the return when savepoint was created and user.
At same moment only one savepoint can be selected.
Note: In case return has a copy, savepoints of this copy will also appear in the list of savepoints, but they
will be shown in the list as red highlight.

Output options
Output path
By default output path is BackUp Retrieved folder in the same folder as current return. But user can change
it using the Browse button.

Output file name
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By default output file name is savepoint number + date and time it was created. eg,
savepoint_677_2019-10-07-034216.xlsx

“Re-load formulas’‘
The ‘‘reload formula’‘ option can be used where users wish to see (for signed-off QRTs in the timestamp
workbook) the formulas included in those QRTs. This option can be unselected in case use don’t need this
formulas.
Note: If the timestamp version requested is before the last signoff time for a QRT then no formulas will be
re-loaded.
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S.19.01 data entry interface
To populate the ‘S.19.01.01.LISTV’ input layer within return you should select S.19.01.01 single list input
layer checkbox on Return Setup in the Company tab.

Selecting this checkbox will add S.19.01.01.LISTV sheet into the annual return workbook and exclude ALL
S.19.01.01 QRTs that would otherwise be included in the return.
This option entails a single QRT worksheet (instead of the multiple S.19.01.01 QRTs, per LoB/currency) in
the annual workbook, with three columns: QRT; datapoint; and value. Each record in this list should
represent an S.19.01.01 QRT datapoint.
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Note: This feature is only available in annual returns.

All existing validations have been programmed to also run on the S.19.01.01 list QRT – there is no loss of
validation coverage in using this option. Further, other QRTs that bring in the data from S.19.01.01 (via
“interactions” formulas) utilize this list instead eg. the SFCR P.19.01.01 QRT is populated from the
S.19.01.01 list QRT.

Note: If a user adds a QRT in S.19.01.01.LISTV that is not one of the LoB and currency combinations
selected in the Return Setup screen then:
- validations will flag a blocking error
- this data will NOT be exported to the QRT layout file
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Convert S.19.01.01.LISTV to QRT layout
There is additional supporting functionality to help the user to visualize the S.19.01.01 data in the standard
QRT layout.
To use it go to Tools in the Tabular ribbon and select Convert S.19.01.01.LISTV to QRT layout

This option can output the single S.19.01.01 list QRT into the original QRT layout style i.e. in the separate
QRT worksheets per LoB/Currency.

Note: The QRTs in the QRT layout file are those based on the LoB and currency combinations selected in
the Return Setup screen i.e. NOT on the contents of S.19.01.01.LISTV C0010
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The generated file will be created in Excel Output Files folder with name: ‘S.19.01.01 LISTV converted to
QRT layout_date.xlsb’

Also, there are 2 options in Convert S.19.01.01.LISTV to QRT layout to include or exclude Tabular formulas
in that generated output file.

So in case, the user will select Include Tabular formulas in output this created output file will include all
Tabular formulas needed. And will be created without any Tabular formulas in case user selects Exclude
Tabular formulas in output

If the Include Tabular formulas in that generated output file option is selected then the output file will include
all applicable Tabular formulas (e.g. total cumulative claims paid subtotals; total LoB sheet populated from
currency level sheets) and if the claims development triangles roll-forward option is selected those formulas
will also be added. How to run roll-forward for 19.01.01 QTRs here.
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Import from S.19.01.01.LISTV QRT layout file
Also there is an option to import data from this output file (with a reverse conversion) back into the main
return s.19.01.01 list QRT.
To do that just select Import from S.19.01.01.LISTV QRT layout file in Tools in the Tabular ribbon.

After this, you will receive Import Excel – from S.19.01.01.LISTV QRT layout file window.

The next step is to select the output file you want to import via Select file button and click Scan button.
If the file is correct you will see S.19.01.01.LISTV QRT in QRT Selection sections.
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Then click Import button and all data will be imported from this output file to the S.19.01.01.LISTV in the
return workbook.
The general aim of the supporting functionality is to allow users to visualize the s.19.01.01 data in the
familiar EIOPA QRT layout and take advantage of Tabular formulas, including roll-forward, in a dedicated
output file that can then be imported back into the main return – leaving the main return much smaller and
lighter as it itself does not include the weight of all the s.19.01 named ranges
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QRT visibility
This functionality allows users to hide QRTs from view in the return workbook. These QRTs still remain in
the workbook and (in general) they are included in all workbook level processes e.g. Validate workbook will
include those hidden QRTs; as will export XBRL whole workbook etc.

These QRTs will not be unhidden automatically (unless the unhide on workbook open option is selected,
see here) and to unhide the Show All button can be used or the specific QRT hide options can be modified
accordingly.

Users can choose to hide QRTs based on a few parameters: return type or QRT status, RFF/MAP they
belong to, or simply select the QRT to be hidden from the list of return QRTs.
To set QRT visibility you should open Tools -> Set QRT visibility.

After this Set QRT visibility window will be opened with the possibility to select QRTs that will be visible in
return.
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Set visibility by return type and/or Sign-off status

In this section, you can choose to set which QRTs are visible based on their type (eg RSR (report to
Supervisors), SFCR, NST etc.) and/or their QRT Signed-OFF status.
For example, if you wished to only see NST sheets that was currently not signed-off you should deselect all
return types except NST in the ‘Return Type’ grid and also deselect the Signed-off checkbox and then hit
Apply visibility filtering button in this section.
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Note: It is not mandatory to select both return type and sign-ff status at the same time, you can select
visible QRTs only by one of this parameters.

Set visibility of specific QRTs

In this section, you can choose to set which QRTs, from the list of all QRTs in your return, are visible.
Here you will have the list of all QRTs that are present in the current return and you should deselect all
QRTs except those you want to be visible and hit Apply visibility filtering button in this section.

Set visibility of specific RFFs/MAPs

In this section, you can choose to set which QRTs are visible based on their associated Ring-Fenced
Fund(s)/ Matching Adjustment Portfolio(s).
For example, if you wished to only see QRT sheets that represented one of your F1 Rff (eg.
SR.01.01.01.F1, SR.02.01.01.F1 etc.) in the below grid you would deselect all ring-fenced funds except the
RFF code that represented F1 and then hit Apply visibility filtering button in this section.
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Also, it is possible to reset all selections in this window and make all QRTs visible in the current return
again. There is section Set QRT visibility at the top of the window. So to make all QRTs visible again you
should hit Show All button.

Note: It is possible to set visibility only by one of the sections at once (eg. only by return type/QRT status or
RFF/MAP they belong to or simply select the QRT to be hidden from the list of return QRTs). So even if
deselect some return variants in return type/QRT status section but then will click Apply visibility filtering
button in RFF/MAP section -> QRTs visibility will be set only by selection in RFF/MAP section.
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Validations for visible QRTs
Hiding a worksheet will not exclude it (in general) from Tabular processing. So when you will run validate
Workbook, then hidden QRTs will also be validated.
But there are capabilities to allow users to exclude hidden sheets in the Validation report.

To do that go to the Validation report in the Tabular ribbon and select Visible QRTs -> show only errors of
show all tests.

After this validations will run only on those QRTs that are not hidden.
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Hidden QRT settings
Users also have the ability to set whether the QRT visibility is retained, or not, each time the return
workbook is opened.
To set this option you should login as Administrator -> go to System Admin in the Tabular ribbon and select
Settings.
There in the System Options tab, you can see Hidden QRT settings section.

By default Auto-unhide QRTs option in not selected. So when you or someone else will open again return
workboook, all hidden earlier QRTs will still be hidden.

But if you will select Auto-unhide QRTs option, on the next return workbook open all hidden QRTs will be
visible again.
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Return workbook cell formatting
If you want to set the cell font or cell fill you should use Return workbook cell formating option.
To use it go to Tools menu -> Return workbook cell formatting

You can select 1 or multiple cells and then select the color in Select cell formatting section and click Apply
formatting button.
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It is possible to select only font or only fill, or both fill and font at the same time.
To update only the fill or only the font, you should leave the option not to be changed as ‘No Change’

In case cell formatting which was selected earlier is no longer required, you can select Default checkbox ->
Apply formatting button and they will set as default (eg. with white fill and black font)

Note: Only cells of the active worksheet can be formatted, you can not select multiple sheets and use this
feature.

Note: Locked cells, such as Tabular formulas, cannot be formatted. So they will be skipped in case they are
selected.
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Formula auditing
Formula auditing allows you to utilise the native Excel functionality of Trace Dependents and Trace
Precedents (these features are not accessible directly in Tabular returns due to the protection levels that
must be maintained).

To use this option go to Tools menu -> Formula auditing.

There you can select to Trace precedents, Trace dependants or Remove arrows.

Trace precedents
Precedents are cells that affect the active cell’s value. To use this option and to show arrows that indicate
which cells are used to calculate the value in the cell you should select some cell -> in Formula Auditing
menu, click Trace Precedents
In this screenshot _C0010_R0070 cell is selected and after hit Trace Precedents. As a result, an arrow
appears that shows which cells affect value in the selected cell.
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Trace dependants
Dependents are cells affected by the active cell. To use this option and to show arrows that indicate which
cells depend on a cell you should select some cell -> in Formula Auditing menu, click Trace Dependants.
In this screenshot _C0010_R0670 cell is selected and after hit Trace Dependents. As a result, an arrow
appears that shows which cells affected by the selected cell.
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Note: Only one cell can be selected at one moment.

Note: Options can’t trace precedents/dependents selectin cells in multiple worksheets at one moment.

Remove arrows
When arrows are no longer needed you can remove them via Remove Arrows drop-down menu.
Remove arrows option – will remove all arrows (both precedent and dependant).
Remove precedent arrows option – will remove only precedent arrows.
Remove dependant arrows option – will remove only dependant arrows.
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System Admin
This area contains some administrative tools and settings and is available only for default Administrator
User.
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Administer Users/Roles
This is the area where you can create new users and roles and also edit existing ones. Note that this is
accessible only to the Administrator user.

Тhere are two things you can restrict/allow for the other users – access to a specific QRT or access to a
specific function. This is achieved by assigning roles to the user. Note that there are two predefined users
User1 and Administrator.

Administrator user is a special account that you cannot edit or delete, but it has some limitations, so it
should be used only for administrative tasks like upgrading returns, creating new users, upgrading DB,
or return recovery.

User1 is just a normal user account that you can change/delete or change its password. This is just a
default account that we have created for you, so you can make a quick start with Tabular without bothering
to create new users first.
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Create/Edit User
You can create a new user or edit an old one from the User tab of the User Manager.

To create a new user just write the name of the user in the text box on top and click Create. The newly
created user will automatically be selected in edit user section. From there you can edit the user’s name,
email and set a password. From the grid at the bottom you can assign specific roles to that user. For more
info on roles and how to create a new one, you can check this thread.

Note that you can select multiple roles to combine privileges and QRTs that user is able to edit. When you
have finished with the configuration don’t forget to click on the Update button to save your changes.

From the edit user area you can edit any existing user as well as setting it to “Inactive” status (the user with
this setting will no longer be able to log in but the user profiles will still be held in the system in terms of
historical audit records etc.)
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Create/Edit Role
Roles are a set number of rules which enable specific functionality. Creating a new role is a 2 step process.

First, you create the role from the following screen:

To do this, just write the Name of the new role and click Create. From the Edit role screen below you can
delete this role or change its name or add a description.
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After you have created the role, you should navigate to Assign Access to Role screen. This is the screen
where the actual functionality/QRT enabled for this role is added. Select the role you want to edit in the
dropdown on top and then you will see two grids.

The first one is where you control what functionality will be enabled for this user. You start with all of the
functionalities checked(enabled). Most of the functionalities are self explanatory and their names reflect and
area on our Ribbon. Note that it is always advised to uncheck the System Admin functionality as this gives
control over all Administrator functions including editing/adding new users.
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The second grid has all QRTs inside. Not the full name of the QRTs are presented, but instead a * is used at
the end to show that this selection is for all QRTs of this type, so selection S.02.01* will give access to all
variants of the balance sheet, so S.02.01.01; S.02.01.02; S.02.01.08 etc.. In this grid you should check only
the QRTs that you want this role to have access to. All unchecked QRTs will be visible for this user with this
role, but he will not be able to add data or edit them. When you have made all your changes, don’t forget to
click the “Save” button to save the role.
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One Click Upgrade
One click upgrade is the main way to upgrade your existing returns and the Tabular main workbook. It is
used to update the database with new data like new validations, formulas, XBRL changes etc.. and also
change some of the supporting files including the QRT templates. Usually an upgrade zip file will be
provided with every new version of the system, but it may also be given to you by the support to fix a
specific issue you are having with Tabular. When download the zip file make sure you first right click on it,
go to properties and unblock it(same as in the screenshot in this thread.

Before updating

If there is a Tabular application update specified in the release email, make sure you install that before
running the data update

How to upgrade:

1. Make sure all users are logged out of Tabular and have closed the return workbooks as a file might
get blocked and the upgrade fail.

2. In order to have access to the one click upgrade feature, you should open the main Tabular workbook
and log with the Administrator user. The feature is disabled for all other users and for specific returns.

3. Select from the ribbon System Admin -> One Click Upgrade

4. In the dialogue that shows select the upgrade file and click the Upgrade button. The process will take
some time(2 to 10 mins) depending on the speed of the machine and the size of the upgrade. Let it
finish until you get the success message, then restart Excel to finalize the upgrade.
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Troubleshooting

Don’t interrupt the process as this might lead to corrupted database files. If experience an error during the
process and upgrade doesn’t complete with a success message, please contact our support and they will
assist you in recovering the database to its initial state from the back-up created automatically before the
upgrade.
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Settings
Here you can find system configurations, DB options and some support functionality.
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System Options
Here you can find some system configurations. Some of them change drastically the system functionality
and performance so change with care and if you are not sure of the consequences of a specific option better
contact SolvencyIISolutions support team.

Audit log disabled

This options disables audit log when checked. No changes of the values in the workbook will be registered.
Note that is a global setting and not per return.

Return Back up disable

This will disable backups to be created for the returns. By default a backup of every workbook is kept when
workbook is saved. If that option is checked this backups won’t be generated – again this is a global setting
and not per return.

Reduced network load

This enables or disables some caching we use to improve performance. Should be kept checked or else you
can hamper performance. More info on this option you can find in this article.

Disable Zip compression

This is an option here related to the one above and if checked it will disable zip compression of some files
we sync for the RNL caching. Should be unchecked unless you face an issue with zip files.

Dynamic Value Tolerance

This option enable some more “generous” tolerances for VL based on EIOPA filing rule S.2.18.(c). It also
affects XBRL export. More info you can find in this help article.

Disable Data Modeling

Disable data extraction and all other features related to Data Modeling. For example, with Disable Data-
modelling set to true the validation feature will not include validation results based on the data modelling
enhancements introduced in version 4.0.0.0. This is global configuration and not per return.

Delete asset highlighting rules

Removes conditional formatting which highlights different asset CIC codes in table 1 of assets QRT (S/
SE.06.02). To be disabled only if you have very large number of assets – over 500k and experience bad
performance. This configuration is per return, so you need to click it in the return you want to strip of the
conditional formatting.
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Network paths

Change how paths are stored an used in Tabular. If they are UNC (\\server1\tabular) or with mapped drives
(X:\Tabular). This should be set according to the user requirements. Generally UNC is better when multiple
users are using the same server but may have different file mappings. Mapped drives may be more
appropriate however if server replication or other setups where the same mapping is used across different
users (but files are placed on different servers and file replication occurs) mapped drive might be better. The
default for the system is UNC. Change with care as this might make some returns not accessible for some
users.

Export engine

Change export engine from VSTO to closed XML (experimental). Do not change if not advised by
SolvencyIISolutions support team.

Annotate output

This adds comments to each fact generated in the XBRL that shows which cell it is coming from. More info
you can find in this help article.
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Dynamic tolerances

For clients that do not prepare the QRT data within Tabular, and wish the Tabular validations to observe the
more “generous” tolerances allowed for under EIOPA filing rule S.2.18.(c); please tick the checkbox
‘Dynamic validations’ to enable this behaviour.
This will also affect the xbrl generation. The decimals property for relevant monetary facts will be set to the
maximum imprecision allowed under S.2.18.(c).

Note that both the actualvalue and the expectedvalue have tolerance applied, as such the two ranges are
compared (Intersect for Equal comparisontype and comparison of min/max actualvalue with max/min
expected value for LT/GT comparisontype)

EIOPA document for the later: https://dev.eiopa.europa.eu/Taxonomy/Full/2.2.0/
EIOPA_XBRL_Filing_Rules_for_Solvency_II_reporting_2.2.0.pdf

BOE document for the same: https://www.bankofengland.co.uk/-/media/boe/files/prudential-regulation/
regulatory-reporting/insurance/solvency-ii-xbrl-filing-manual.pdf

This is another link with practical examples on how this calculations are done: http://faq.eurofiling.info/
decimals/
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Annotate output

XBRL in general, and the EIOPA filing rules specifically, allows for comments to be included in the xbrl file
content. Selecting this feature will add annotations to the XBRL file against every fact and most dimensions
with the sheet name and the Named Range. This feature has been included at the request of users wishing
to map XBRL Regulator Portal validation messages (that usually identify the location in the xbrl file eg
metric mi124, context “c124”, line 2345) with the QRT data point source for the xbrl content.
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When the fact is coming from a list QRT like S.08.01 it will have format like S.08.01.01.01!_C0040.7 —
where the C0040 is the column in the qrt and 7 is the row.

Note that although this is an officially supported by XBRL and EIOPA filling rules there is still a risk that
some specific regulator might reject the annotated XBRL.
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Reduced network load (RNL)

Enabling Reduced Network Load should improve perfomance when the Tabular database and files are
placed on a “slow” shared network. By default it is set to ON and can be changed here.
Note, turning off RNL can negatively affect the system and decrease the perfomance.

When RNL is ON it uses a local cache of the main Tabular database for reading transactional Tabular data
and some static data.
On the workbook save action the local DB is synced from the network. Tabular logging is also sent to the
local cache folder and saved up to network logging folder on the save return action.

By default local folder path is set to ‘%Appdata%\Tabular’. Note, that path can be updated here:
SystemAdmin > Settings > DB Options.
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Disable Zip Compression

For better perfomance using zip files when syncing DB and data for RNL is enabled by default.
Disable only if you have some problems with zip/unzip operations.
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Support Options
This options are intended to be used only by the SolvencyIISolutions support engineers or if specifically
requested by the support team.
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Logging
Here you can change logging level and enable advanced system logging
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Logging level
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Environment logging

By default Advanced system loggin is Off.
In case it is changed to On all environment information will be added to log file once,when user launches
any Tabular file for the first time.
This environment information can help to investigate some potential issues.
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DB Options
This area hold all options related to the database and it’s maintenance.

Local DB location

This option changes the location which is used for caching database and templates. By default (i.e. if this is
not set specifically) location used is ‘%Appdata%/Tabular/’ . Please contact SolvencyIISolutions before
changing that as ti may result in bad performance of the application.

Update current return path in the DB

This option will update the path registered for the specific return in Database. It will be updated to the
current location of the return – this should be used when you move the return to a new location. This can be
used to remove the Not Registered message on starting workbook.

Update GoldenCopy return variant table

This option allows to change the goldencopy return for the current return. More info on that you can find in
this help article.

DB maintenance

The first two buttons – Compact and Shrink are used to optimize the database to reduce the size of the .sdf
file. The third one “Repair” is used in case of some corruption in the database and can help to restore its
normal functioning.

Update all returns with a new central DB path

This option is used to change the path to the database that is in each return Custom properties. It is used
when the location of the database is moved. Note that in order for it to work Tabular returns should be able
to be found by the system, which means they should be at the same path logged into the database, if they
are moved as well and this path is no longer valid nothing will be updated. If you change location of the
Database we strongly advise that you contact SolvencyIISolutions support team to guide you through the
process and ensure that it goes smoothly.

Central DB settings and location

This option will open a dialogue where you can configure the type of database used: SQL Compact or SQL
server and also modify the connections string of the database. Please do not change by yourself and
contact SolvencyIISolutions support team.
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Update goldencopy return variant
In order to support data modeling features each return should have a golden copy for specific return variant.
In Tabular return variant is a set of QRTs used for a specific scenario. Tabular returns can contain more
than one return variant. For example a Solo annual Irish return with NSTs and SFCR have 3 return variants:
bE – Annual ECB reporting Solo
bIE- Annual Solo IE NSTs
e- SFCR Solo Annual

Full list of Tabular return variants and their codes is attached at the bottom of the article. Sometimes this
different return variants might be in different returns. For example you can create one return for EIOPA qrts
and a separate one for the NSTs. Usually golden copy return variants are filled in automatically in the
database, but in case some change is needed you can do it from here. Here is a scenario where you want to
do that.

Lets say you create 2 annual returns for the same company and reference date. By default Tabular will set
the second one (the one created last) as the goldencopy for this period. However if you decide to file the
one you created first – you will need to specifically set this return as goldencopy for the period. You can do
that by adding the specific return variant lets say bE into the textbox and click update. Note you can only do
that one return variant at a time and also you should be in the return you want to make the goldencopy.

Code Return variant

a Quarterly Solvency II reporting Solo

b Annual Solvency II reporting Solo

c Quarterly Financial Stability reporting Solo

d Annual Financial Stability reporting Solo

e SFCR Solo Annual

f Quarterly Solvency II reporting Group

g Annual Solvency II reporting Group

h Quarterly Financial Stability reporting Group

i Annual Financial Stability reporting Group

j SFCR Group Annual

o Quarterly Solvency II reporting Third country branches

p Annual Solvency II reporting Third country branches

s Day 1 reporting Solo

t Day 1 reporting Group

u Day 1 reporting Third country branches
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v Quarterly Financial Stability Third country branches

x Annual Financial Stability Third country branches

z Annual reporting Special Purpose Vehicles

aE Quarterly ECB reporting Solo

bE Annual ECB reporting Solo

oE Quarterly ECB reporting Third country branches

pE Annual ECB reporting Third country branches

bGB Annual GB NSTs

aIE Quarterly Solo IE NSTs

bIE Annual Solo IE NSTs

fIE Quarterly Group IE NSTs

gIE Annual Group IE NSTs

asIE Quarterly Solo Bi-annual IE NSTs

fsIE Quarterly Group Bi-annual IE NSTs

aMT Quarterly Solo Malta NSTs

bMT Annual Solo Malta NSTs

aCY Quarterly Solo Cyprus NSTs

bCY Annual Solo Cyprus NSTs

bMTAP MFSA application annual return

bIM Annual Solo Cyprus NSTs

aIM Quarterly Solo Cyprus NSTs
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Known Tabular issues
Auto generation of N.IE.13 data includes numbers from last period as well
FIXED in 4.1.0.2

Description: The auto-generate NST.13 feature can include SE.06.02 data records relating to the previous
quarter’s return. This is due to an invalid condition within the feature SQL that should filter out all SE.06.02
data within the Tabular database except that for the current return, but does not in all cases.
For example, running the auto-generate NST.13 feature for the Q1 2019 return; the error meant that Tabular
would load into the current return’s NST.13 sheet the transformed SE.06.02 records from the Q1 2019 AND
the Q4 2018 return – resulting in NST.13 containing incorrect data (essentially double-counting the
SE.06.02 data sets from current and previous returns for all asset IDs found in both returns). Note the same
problem affects the validations.
Workaround: None
Versions: 4.1.0.1

Edit return adds link to user local data file
FIX PENDING NEXT APPLICATION UPDATE

Description: Edit return process has a bug whereby if S(E).06.02 is added into the return workbook via Edit
return then an external link is added to the local cache files (TabularS2.xlsm workbook) of the user who
performed the edit return. This causes problems when other users access the return workbook as Excel
cannot resolve this link. Further the Break links option in Excel Data > Edit links does not remove this
external link.
Workaround: Use System Admin > Settings > System settings > ‘Delete asset highlighting rules’ (note this
disables the Analysis > Highlight asset rows feature in that workbook)
Versions: ALL

UK NST.07 (N.UK.07.01.Y0) R1000 reconciliation with s.05.01
FIXED IN 4.1.0.1 DATA UPDATE

Description: Based on the BoE LOG guidance (https://www.bankofengland.co.uk/-/media/boe/files/
prudential-regulation/regulatory-reporting/insurance/nsts/ns07-log-
file-31-12-18.pdf?la=en&hash=4635B083B45CA36C8FC6D26B5D870BC0E86F2DE0) the formula (and
accompanying cross-QRT Tabular formula) in N.UK.07.01.Y0 C0010 R1000 is linking to S.05.01 R0550
(+R1900 where available)
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We think this is a mistake in the BoE guidance and will contact the BoE to inform. The formula will be
updated in the next Tabular update to reference R0500 + R1800
Workaround: None
Versions: 4.1.0.0

EV55 validation gives invalid result
FIXED IN 4.1.0.1 DATA UPDATE

Description: EV55 validation gives invalid result incorrectly checking that E.03 and/or S.17.02 amounts
specified by country are EQUAL to 90% of S.17.01 (total) instead of being greater than or equal to the
S.17.01 (total)
Workaround: None
Versions: 4.0.0.0

Return Setup includes S.04.01 when ‘Company > Business undertaken outside home country’ is not
selected
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FIXED IN 4.1.0.1 DATA UPDATE

Description: S.04.01 sheets should only be included in the return where ‘Company > Business undertaken
outside home country’. However, due to a setup error Tabular is including S.04.01 sheets in the annual
return even when this option is not selected
Workaround: Set S.04.01 worksheets to ‘not include override’ in QRT Selection screen (note this can be
done in edit return also)
Versions: 4.0.0.0

*BV779 validation with severity ‘Blocking’ instead of ‘Non-Blocking’ *
FIXED IN 4.1.0.1 DATA UPDATE

Description: The wrong severity has been assigned to this validation. Please read the result as ‘Non-
Blocking’ instead of ‘Blocking’. For example, there are cases where CIC 8 where S(E).06.02 C0110 is
required and in these cases this EIOPA validation should flag a ‘Non-Blocking’ validation for users to
confirm C0110 has been filled appropriately.
Workaround: For now you can just ignore this validations where not applicable
Versions: 4.0.0.0

BV1014 validations do not detect where S.08.01 C0150, C0160, C0170, C0180, C0210, C0220 are 0
FIXED IN 4.1.0.1 DATA UPDATE

Description: These fields should be >=0 according to the xbrl Non-Blocking validation, however Tabular only
flags when they are <0 i.e. if their value is 0 the validation should flag an error but doesn’t
Workaround: None
Versions: 4.0.0.0

BV993 validations give invalid result for valid S.08.01 CIC
FIXED IN 4.1.0.1 DATA UPDATE

Description: The S.06.02 valid CIC list has incorrectly been used for validating appropriate CIC usage in
S.08.01
Workaround: For now you can just ignore this validations
Versions: 4.0.0.0

Workbook shows that it is being used by another person but noone else have it opened at the
moment
FIX PENDING

Description: This is usually just a consequence from workbook being corrupted or just showing some
message that goes behind the main window, but is locking the workbook so it is shown as read only.
Workaround: You can try few things. Open the workbook not by double clicking on it, but by opening Excel
first and then File-> Open. This changes the order of opening events, so can help in the scenario. You can
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also just click to open the workbook in read only mode. Then usually you will see what is the actual problem
leading to this message. If it is workbook corruption – check this article for how to resolve. When the
underlying issue is fixed – it should stop showing this message.
Versions: 3.0.0.0 and above

Facts with integer values – xbrl ri facts are reported with 1 decimal digit instead of 4
FIXED in 4.0.0.0

Description: The xbrl documents are vague on the number of decimal digits required for ri facts and we
implemented with 1. At some point some regulators started to require them to be with 4 decimal digits.
Workaround: none
Versions: 3.0.0.0 and above

Workbook is corrupted and needs recovery
FIX PENDING

Description: It is not directly related to Tabular but more the combination of big workbooks with a lot of
sheets, lots of named ranges and mostly external workbook links. It happens mostly to clients using links to
Siimplify workbook.
Workaround: Usually just clicking repair for the workbook will be enough. Note the repaired workbook is up
to date and it is not reverting some of your data changes that you made last. More info you can find in this
article.
Versions: 3.0.0.0 and above

Using edit links menu to change the source of a link throw error
FIX PENDING

Description: In some cases when a user uses the Tabular integrated edit links and try to change the source
of a linked workbook an error will show stopping or the process (you might need to forcefully close excel as
it shows error for every formula).
Workaround: User can delete and add again the links manually if they are not that much. If they are a lot –
user can export the sheets with the links to Excel and then modify the links in the export using the Excel edit
links and then Import this file into the workbook using the preserve user formula option. You can also
contact support so they can help by unprotecting your workbook and using the default excel edit links.
Versions: 3.0.0.0 and above

Importing wrong values into Z named ranges in some QRTs
FIX PENDING

Description: The Z named ranges are usually filled in from return setup and locked and you can’t edit them
in Tabular. However due to a gap in import you can import a value over them and when this value is
incorrect it breaks the XBRL export as this fields expect a specific value to generate the proper XBRL
dimension.
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Workaround: Either make sure you never manually change this fields in your import file(excel file etc..) or
you can run edit return without changing any value in the return setup and this process will overwrite the Z
values with the correct ones.
Versions: All

Dates exported to Malta NST workbooks are sometimes not correct if you use windows culture with
different format than dd/mm/yyyy
FIXED in 3.0.0.6 DB version

Description: Dates exported to Malta NST workbooks(both quarterly and Annual) are sometimes not correct
if you use windows culture with different format than dd/mm/yyyy. As we apply some conversions to this
dates, for specific dates it is not converted correctly so you might end up with misplaced dates/months or no
date at all.
Workaround: Change dates manually in the generated file
Versions: All

S.29.04 .01 for QRT was not being generated for Life companies
FIXED in 3.0.0.5 DB version

Description: For non-life insurers with non-life annuities exposures, the S.29.04 QRT for life business was
not being included automatically in annual returns
Workaround: Add S.29.04.01.ALI via the ‘Add multicopy’ QRT in QRT selection
Versions: 3.0.0.0 to 3.0.0.4

S.29.04 Non-life annuities values incorrectly brought into S.29.03 Non-life column
FIXED in 3.0.0.4 DB version

Description: For non-life insurers with non-life annuities exposures, the formulas in S.29.03 reconciling with
S.29.04 were not correctly allocating the non-life annuities S.29.04 QRT into the S.29.03 life column.
Workaround: Remove the Tabular interaction formulas and correct
Versions: 3.0.0.0 to 3.0.0.3

Roll forward feature doesn’t populate the H.HV sheet
FIXED in 3.0.3.0 application version

Description: Roll forward sometimes fails to extract the data from the referenced return and fill the H.HV
sheet. This might be caused by having PrintAreas NamedRanges in it or having hidden formulas(present in
some Malta NSTs)
Workaround: You can get around the issue by running the macro from this link the referenced return and
then repeating the process (you can run Tools->Refresh H.HV helper sheet)
Versions: 3.0.0.0 to 3.0.2.0

UK NST data points not populated from Tabular return
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FIX PENDING – Next Application Release

Description: Due to the protection levels in this workbook is not possible to populate all NSTs. The following
are not populated or only partially populated:
NS.08
NS.09 C0090 and C0100
NS.11 is pre-set to populate up to 3 instances of NS.11. If you have more than 3 combinations of accident
year/underwriting year, line of business and currency to be reported please contact our support team who
can configure to support additional instances. Note NS.11 r0310 – r0370 (inflation rates) are not populated
Workaround: You can get around the issue by manually entering these values into the applicable cells in the
PRA workbook generated by Tabular
Versions: All

Tools – Apply non ECB Transformation fails as it doesn’t export properly S.02.02, S.05.02
FIXED in 3.0.0.0 application version

Description: When have empty columns in S.02.02 or S.05.02 – Tabular tries to export the 0s that are in the
formulas in this columns and because there is no currency selected Xbrl creation for this fact fails. Not this
is handled in normal XBRL export but not for the Non ECB Transfomation.
Workaround: On the affected sheet select all the subtotals for the non used columns, select Subtotals >
Selected Cell > Delete formulas. This will remove the formulas in this columns and then you should
manually delete all the 0s in this fields. Then export will work.
Versions: R.2.2.6.0 and below

S.26.01, S.26.05, S.29.04 subtotal in sheet formula is hardcoded to 0
FIXED in 2.2.1.8 DB version

Description: There are some cases where the Tabular return workbook incorrectly has the subtotal formula
removed in the sheet, instead the cell is set to 0 value (no formula in the cell).
Workaround: On the affected sheet, select Subtotals > Selected QRT > Replace formulas. This will reload
the correct formulas
Versions: R.2.2.1.7 and below

S.21.03.01.AS is not generated when Assistance lob selected for euro currency
FIXED in 2.2.1.8 DB version

Description: When in Return Setup is selected Assistance LOB for euro currency or Non Material — the
corresponding S.21.03.01 QRT is not generated.
Workaround: Ask SolvencyIISolutions support team for a custom upgrade file, to fix for you.
Versions: R.2.2.1.7 and below

Invalid formulas in S/SR.26.01 and S/SR.26.03/04 in pre-R2.2.1.2 DB created returns
FIXED in version 2.2.1.2DB version
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Description: Problem is that although this formulas are fixed in latest data(2.2.1.2), due to a technical
limitation they are not directly corrected into this templates. The affected fields and cases are:
SR/S.26.01 c0080 r0100, S/SR.26.03/04 c0080 r0400 -Gross SCR figure for interest rate risk and lapse risk
respectively
Correction to take into account the scenario used to derive the net SCR figure and utilise this scenario from
the gross figures
SR.26.01 c0080 r0100, c0060 r0420, SR.26.03/04 c0060 r0400 Net SCR figure for interest rate risk, credit
derivative risk and lapse risk respectively
Correction to include the impact on the firm as a whole for each of the bidirectional scenarios and to use
within each RFF SR. QRT the applicable scenario
Workaround: Go in this sheets and do a Subtotals -> Selected QRT -> Replace Formulas from the ribbon
and the same with Interactions -> Selected QRT -> Replace Formulas. This will replace the formulas with
the correct ones.
Versions: R2.2.0.0 and R2.2.1.1 DB

Slow performance when exporting group of sheets to Excel
Fixed in version 3.0.3.0

Description: You can get slow performance if exporting number of sheets to Excel. The performance
decrease the more sheets are selected and especially if they are multicopies or with a lot of interactions.
Workaround: If you export to Excel the whole workbook the performance will be much faster as checks if
interactions are broken is not performed.
Versions: 2.2.3.0

Validation error when don’t complete primary key fields (e.g. reinsurer code, broker code) in list
QRTs
FIXED in version 2.2.3.0

Description: You can get validation error when don’t complete primary key fields (e.g. reinsurer code, broker
code) in list like S.31.01.01.02
Workaround: If this is a subtable of a QRT e.g. S.31.01.01.02 but S.31.01.01.01 is completed then this
validation can be ignored and the S.31.01.01.02 table can be left empty
Versions: 2.2.0.0

Some formulas not right when language setting of excel is not English
FIXED in version 2.2.3.0

Description: Few complex array formulas in S(E).02.01 might not work as expected when language setting
of Excel is not set to English. If you notice such issue contact support so they can explain and provide
workaround
Workaround: For workaround contact support
Versions: 2.2.1.0
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Annual MFSA NST export is not working
FIXED in version 2.2.3.0

Description: Although the option is added to the ribbon under Export it is not working at the moment.
Workaround: No workaround
Versions: 2.2.1.0

EV35 and EV38 validations give invalid result when you have SE.01.01.16 and E.01.01.16 both in the
return
FIXED in version 2.2.1.0

Description: When have E.01.01.16 an SE.01.01.16 in same return — they get mixed up and you are getting
the wrong result in EV35 and EV38 validations. They show DataError as Actual Value.
Workaround: For now you can just ignore this validations which will not affect your filling in any way.
Versions: 2.2.0.0

LEI code type and code not properly exported to XBRL from S.01.02.01
FIXED in version 2.0.2.2

Description: Our XBRL engine should do the combination of S.02.01 R0030 and R0020 for you but the call
to the code that does this was dropped accidentally as part of the reworking of the XBRL engine to account
for large datasets in 2.0.2.1. This is why Tabular validation passes for you when you have the LEI code
without the LEI prefix in R0020 but fails when you add it because the validations think the XBRL will then be
LEI/LEI/[LEIcode].
Workaround: You can get around the issue by entering the LEI prefix directly in R0020 – although of course
Tabular will give a validation error
Versions: 2.0.2.1

Validations for S.25.01.01.SF fails with “Cannot convert type ‘System.DBNull’ to ‘bool’ “
FIXED in version 2.0.1.0

Description: The workbook contains an invalid NamedRange for the specified QRT and it causes the
Completeness validations to give error
Workaround: You can get around the issue by removing the PrintArea named range from the list of
NamedRanges in the workbook
Versions: 2.0.0.0

Vendor tag was added to the instance generator and this was not accepted by CBoI
FIXED in version 2.0.2.0

Description: When create an XBRL file at the top there is Instance generator tag which we exported like
that:
< ?instance-generator id=“Tabular” version=“2.0.1.0” vendor=“Solvency II Solutions Ltd”
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creationdate=“2016-04-05 11:52:17” ? >
This was causing an error at the CBoI test window. The error is “Declaration of software vendor is missing
or incomplete in the instance document “
Workaround: You can get around the issue by removing vendor part of the Tag, so resulting string becomes:
< ?instance-generator id=“Tabular” version=“2.0.1.0” creationdate=“2016-04-05T11:52:17” ? >
Versions: 2.0.0.0, 2.0.1.0

Import breaks Array formulas in S.02.01
FIXED in version 2.0.4.0

Description: After importing data to the S.02.01.01 array formulas are broken. Array formulas are marked as
: {=C0030_R0040+ etc…}
After the import the {} are removed so this becomes normal formula and give completely different result.
Workaround: You can get around the issue by using the replace interactions option from the Ribbon.
Interactions -> Selected QRT -> Replace formulas
Versions: 2.0.0.0, 2.0.1.0, 2.0.2.0, 2.0.2.1, 2.0.2.2

XBRL incorrectly exports code type as NONE instead of None
FIXED in version 2.0.2.0

Description: Our XBRL engine was exporting NONE value for issuer/counterparty/group code type fields
(usually in lists like S.06.02, S.08.01 etc…) and this was not passing the validations on regulator portals as
its case sensitive.
Workaround: You can get around the issue by finding and replacing the NONE values in the XBRL file with
None
Versions: 2.0.0.0, 2.0.1.0
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Troubleshooting
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I Can’t Get Started
Please select from one of the options within this selection.
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I Can’t Login to Tabular
Please contact the primary user / owner of the Tabular application in your organisation.

They will have access to the main Administrator Login and will be able to update your password.

If you are the administrator and you are unable to login, please contact our support Desk.
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Tabular is too Slow
There are two things why this happened:

1. The machine where Tabular is installed maybe slow.

2. When you are working through a network, the Network location you are connected to is slow.

Solvency II Solutions User Guide - 6.0.0.0

Page 335 of 365



I Made a Mistake
Please select the option within this selection
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I Made a Mistake, How Can I Revert Back?
You can revert back to an earlier point in time when you noticed problems or workbook gets corrupted. First,
log-in as administrator to do this:

1. Click System Admin on Tools section of the ribbon.

2. Select Return Recovery.

3. The restore company window will open when you select the company file, backup files will be then
populated.

4. Select one of the backup files to restore your return to this point.

5. Click Retrieve button at the bottom of the window.

You will notice in your return workbook that old returns has “old” appended to its file name and your new
return will be that backup file you recovered.

Note that when you choose a restore point, only the changes up to that certain time are saved.
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I Have a Problem with Excel
Please select from one of the options within this selection.
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I See Some Strange Effects in Non-Tabular
Workbooks
If you see any strange effects with non Tabular workbooks, please email us with the issue and details
immediately.
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I Have a Problem with a QRT
Please select from one of the options within this selection.
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I’m Missing a QRT
QRTs are included in the return when the properties required to generate it is selected. Here’s what you can
do:

1. Review your company details and the selections made.

2. If you don’t know what properties are needed, you can ask the support line for the list of rules and guide.

3. You may also add the missing QRT through manual override, however, this action may not always be
applicable to all QRTs. For instance, S.02.02.01 is generated when balance sheet reporting by currency is
selected. If you choose to override it instead, you will have the QRT, but the Line of business (LOB) are all
hidden.

To know more on how to add a QRT click here
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S.06.02 *
S.06.02.01.01 and S.06.02.01.02 (List of assets) are generated when Quarterly exemption reporting in
the Company tab is selected.
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I Have an Extra QRT
To remove an extra QRT, please click here
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A QRT is Missing Data Points
Please contact support desk for assistance.
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The QRT Structure Looks Incorrect
Please contact our support with the exact nature of your query.
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I Have a Problem with a Formula
Please select from one of the options within this selection.
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A Formula is Incorrect
Tabular has predefined formulas. If in some cases when the formula might not seem right, please do the
steps below:

1. Check drill down to make sure all data points are correct or to identify any issues.

2. If the above step is fine, then try to replace the formula to restore it.

• Click Subtotals/Interaction under Validation section of the ribbon.

• Option are available for replacing formula of a selected cell or selected QRT.

• Click Replace Formula.

• A confirmation message appear that formula has been replaced.

Additional information, click here.
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A Formula is Missing
At some point, the formula is removed when the data point inside the equation is referencing to another
QRT that is not included in the return. These are the formulas in an interaction cell.

Note that the data point will become a normal cell, instead of a light green:
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I Want to Add my Own Formulas
Custom formulas can be added right away to a normal cell. However, for a predefined formulas in Tabular,
you have to remove the existing one, before adding your own formula.

To remove formulas:

1. Click the appropriate formula type you want to remove in Validation section of the ribbon.

2. You can choose to remove the formula from a selected cell or selected QRT.

3. Click Delete formulas.

4. A confirmation message appear that the formula is removed.
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I Want to Link to an External Workbook
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C0170 is showing 0 in S.06.02.01.01/
SE.06.01.16.01 etc..
In some cases the C0170 column of the List of Assets is not calculated properly and stays 0. This happens
when you use formulas to populate the data in this list and when there is no value in the formula you set
empty string(“”) our formula for C0170 can’t work with strings and it shows 0. You can workaround that by
setting 0 instead of “” in your formulas. This is important for columns C0130, C0140, C0180, C0370, C0380.
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I Have a Problem Importing
Issues with importing files maybe due to:

A. Header is not Right

Make sure the header of the file to be imported is the same with the QRT sheet.

B. Header not Recognised by the System

Some headers might have some names that are not in the database, double check the files and the sheet
name. Also for multi-copy QRTs, make sure the header in the import file is exactly the same in the QRT.

C. Number of Rows does not Match the Number of Rows Specified in the Database.

If the number of values exceeds or less than what is specified, then it won’t be imported.

In addition, if you are importing into an interaction or a closed list value cell select overwrite.

You can see the Overwrite Interaction option in the import window.

To import on a text field, select Overwrite Non-Monetary option in the import window and deselect
“Consolidate’
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I Have a Problem with a Validation
Please select from one of the options within this selection.
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I Don’t See the Validation that I am Expecting
Two options to run Validation report:

1. Show only errors
2. Show all test

Make sure you have selected not just to show only errors option, otherwise, the correct report validation will
not be in the list. You can contact our support if you’re running full validation and still not seeing what you
are expecting.

Check here to see how to run the validation report.
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I Have a Problem with Reg Hub
Please select from one of the options within this selection.
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I Can’t View Regulatory Hub
When you click the regulatory hub icon on the ribbon, it will show regulatory hub task pane. You can find it
on the right side of the return workbook:

If you cant’ see entries as you move from one datapoint to another, please check the following:

1. Make sure that automatic refresh is enabled.

2. Full library is not selected.
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I Have a Problem with XBRL
Please select from one of the options within this selection.
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My XBRL File will not Load into our Regulator
Portal
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I Have a Problem with Tables
Rows can be added in a table. This can be done with Append or Append++ button under Tables section of
the ribbon. Click here to see how it works.

If you’re having problem with subtotal formulas in the table, you can try to delete the formula and then
replace it. Check how to remove/replace formula by clicking here

When the drop down list is messed up, broken, or accidentally removed, you can easily restore it.
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I can’t create a return
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I can’t create a return because it says I have
opened workbooks
Sometimes although it seems that you doesn’t have any opened workbooks you actually have, but they are
hidden (usually they open on starting excel). To close this workbook and proceed with return creation do the
following steps:
1. Go to View tab in Excel
2. Click Unhide button

3. If there is a hidden workbook this button will be enabled – on click it will give you a list of hidden
workbooks, Unhide them and then close them and proceed with return creation.

Solvency II Solutions User Guide - 6.0.0.0

Page 361 of 365



Corrupted workbooks that need repair
Excel sometimes shows a message that the workbook is corrupted. It is not directly related to Tabular but
more the combination of big workbooks with a lot of sheets, lots of named ranges and mostly – external
workbook links. It happens mostly to clients using links to Siimplify workbook.

We have not found a remedy for that on our side, but usually just repairing the workbook does the trick. A
message that workbook is opened by another user shows with some clients as well. This is just some
additional message that you get with some excel versions, but related to the same problem. Usually you
should just click open read only, so workbook is loaded and repaired. Then on next open you should be able
to open the workbook without this message.
In rare cases you can also get a fail message that workbook can’t be repaired. A message like that:

A good thing to try always in case of such message is to open Excel first and then use File -> Open to open
the problematic Tabular return. This changes the sequence of events on open and can help with the issue.

As a summary – in case of corruption try :
1. Close all excel workbooks
2. Instead of double clicking on the corrupted one from explorer— Open excel first and from there File->
Open
3. If you get corrupted message – click recover, if you get the read only one – click read only and then
repair. After repair is finished -> save and open again. Note that the workbook should be in the state you
last saved it, so you should not loose any data.
4. Another thing you can try in case of corruption is to open the workbook using open and repair option
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This menu you can open from Excel : File -> Open select the file and then expand the open button for the
submenus and select Open and repair.

To reduce such issues to a minimum always make sure that all links are valid — if you have some old links
where the targeted workbook is moved/deleted – remove these links (you can edit this links in Tabular by
tools-> Edit links).

If any of the above doesn’t help please contact our support to assist with the issue.
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Useful Information
Company Registered Address

27 Ellenbridge Way
South Croydon
CR2 0EW

Main Correspondance Address (For legal and billing related documents)

27 Ellenbridge Way
South Croydon
CR2 0EW

London Office Address

Solvency II Solutions Ltd
2nd Floor, 1-5 Clerkenwell Road
London
EC1M 5PA

Key Telephone Numbers Support : 020 7193 8846 Sales: 020 8133 5709

Support email support@solvencyiisolutions.com

Accounts email accounts@solvencyiisolutions.com

VAT Number 203539139

Bank Details

Bank: HSBC
Account Name: Solvency II Solutions Ltd
Account Number: 02135809
Sort Code: 40-03-04
IBAN: GB12HBUK40030402135809
BIC / SWIFT : HBUKGB4B

Beneficiary Bank Address:

HSBC
Moorgate
The Helicon, 1 South Place, EC2M 2UP,
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London
England

Beneficiary (Individual Bank User) Address:

Mr Adrian Kent
27 Ellenbridge Way
South Croydon
CR2 0EW

Payment Terms (Applicable to all issued invoices)

Payment should be made within 30 days by money transfer only to the above account.
Please use a reference of the invoice number.
Our payment terms are in line with UK law, we may choose to apply interest where payment is late, by
issuing a new invoice with interest included. For more information, please see here:
UK Invoice Payment Terms
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